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| ntroduction

1.1 About this manual

Thismanual isaguide for TopsPIN plotting and printing. It describes the complete
TopspIN print/plot functionality, both interactive and automated.

This manual consists of three parts:

e Part I: Quickstart
Givesaan overview of plotting in ToPSPIN in general and the Plot Editor
in particular.

e Part|l: Plot Editor Reference
Describes the entire Plot Editor in detail.

e Part I1l: Questions & Answers
Describes frequently used plotting procedures.

1.2 System support

TopsPIN runs on Windows and Linux systems. The elementsinvolved in plotting
like datasets, portfolios and plot layouts are interchangeabl e between the two plat-
forms. The description and screenshots in this documentation are taken on aWin-
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dows computer. Differences in interface and functionality between Windows and
Linux are described in Chapter 11.

Note, that imported WMF graphicsin alayout created under Windows, will not be
displayed or printed on Linux systems. Vice versa, imported EPSI graphics, ina
layout created under Linux, will not be displayed or printed on Windows systems.

1.3 Conventions

Font conventions
Various font styles are used to represent different types of information.
pl ot - TopsPIN command line commands are in courier bold italic

Zoomin - menus or buttons to be clicked in the TorsPIN window or the Plot
Editor window are in times bold italic

Curve - Diaog sections are in times bold
| ayout . xwp - filenames are in courier

name - any name which is not afilenameisin timesitalic

File/directory conventions
<tshome>

the TopPsPIN home directory (default C\:Bruker\topspi n under English Win-
dows X P and /opt/topspin under Linux)

<userhome>

the user homedirectory (default C:\Documents and Settings\<username> un-
der English Windows XP and /home/<username> under Linux)

<dir>/data/<user>/nmr/<name>/<expno>/pdata/<procno>
datadirectory where:
<dir> = top level data directory

<user> = user part of the data directory

1) If C isthe default drive.
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<name> = data name: name part of the data directory
<expno> = data experiment number: expno part of the data directory

<procno> = data processing number: procno part of the data directory
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2.1 Plotting in TOPSPIN

Plotting/printing in TOPSPIN gtarts, as in most other applications, by clicking the
menu:

i File— Print [Ct r | +p]
which is equivalent to entering pr i nt on the command line.

Thiswill open the dialog shown in Figure 2.1, which shows you the 3 basic meth-
odsfor printing NMR datain TOPSPIN.

These methods (Options) are:
e Print active window [prnt]

Thisoptionwill print the current dataset asyou seeit inthe ToPsPIN datawin-
dow, including the displayed region, intensity scaling and displayed compo-
nentslike title, parameters, integrals, peak labels etc. The Required

par ameter s section of the dialog is disabled, no plot layout are used and you
will be prompted for the target printer.
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EM Print [Ctrl:P] - plot
Options

() Print active window [prit]
@ Print wwith lenyout - start Plat Editor [plotf
O Prirt with layvout - plot directly [autoplat]

Reguired parameters

Lay0LT = 1D H oo v

Use plct limits

(%) from screen [ CY

) from Plot Editor Reset Actions
() &= saved in Plot Editor

Fill clata =&t list

{:} from your default portfalio

D Crverride plotter saved in Plot Editar:

O from pottfolio saved in data et

CURPLOT = |hp LaserJet 1300 PS

l O ” Cancel ” Help l

Figure2.1
Print with layout - start Plot Editor [plot]

This option will start the Plot Editor, the interactive program for viewing or
designing plot layouts. The current dataset is displayed, according to the
LAYOUT, Plot Limits, Dataset List and Plotter set in the Required Parame-

ters section.
Print with layout - plot directly [autoplot]

This option will print the data, according to the LAYOUT, Plot Limits, Data-
set List and Plotter set in the Required Parameters section.

Thefirst option (command pr nt ) isthe simplest way to plot your data. It is useful
for plotting a single dataset as you see it on the screen. This option is further
described in paragraph 2.2.

The second option (command pl ot ) isinteresting for using or designing more
sophisticated plots. It allows you to create Plot Editor layouts in which you can
freely add, delete and manipulate Sandard and NMR graphical objects.

The third option (command aut opl ot ) ismainly used in automation. It uses pre-
defined Plot Editor layouts, which can be standard Bruker layouts or user defined
layouts.
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All three commands can be entered on the command line;
e toplot the current dataset as you seeit on the screen:

enter pr nt
e to preview the current plot layout or create anew plot layout:

enter pl ot

< toplot the current dataset according to the current plot layout:
enter aut opl ot
When entered without arguments:
pl ot will usethe plot limits from the screen
aut opl ot will set the plot limits according to the automation reset actions L)

Both commands will use the layout defined by the processing parameter LAY -
OUT. This parameter can be set by entering | ayout onthe command line. Note
that the layout can be specified asafull pathname or by using one of the following
abbreviations (see also Figure 2.1):

+ : the standard layout directory <tshome>/plot/layouts/
~ : the user home directory
#  current processed data directory (PROCNO)

Note that the LAY OUT parameter can specify multiple layouts, separated by semi-
colons, e.g.:

+/1D_H.xwp;+/1D_H+int.xwp
Thisfeatureis especialy used in automation 2,

The behavior of pl ot and aut opl ot can be manipulated with command line
arguments. For example:

autoplot -f -c -i

will print the dataset(s) in the default portfolio (- i ), on the printer defined by
CURPLOT (- ¢), using the plot limits from screen (- f ).

1) Because it ismainly used in automation.
2) autoplot prints al layouts specified in LAY OUT, whereas plot only opensthe first layout.
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The command line arguments are displayed at the top of the pr i nt dialog (see
Figure 2.2). Just enter pri nt , try out different Required Parameter settings and
look at the corresponding command and arguments.

FA Print [Ctrl:P] - autoplot f -c -i

Options

() Print active window [prit]
(:) Print wvith layout - start Plot Editor [plot]
@ Prirt with layvout - plot directly [autoplat]

Reguired parameters

Lay0LT = 1D H oo v

Uze plat limits Fill tdata =et list
(%) from screen [ CY
) from Plot Editor Reset Actions
O asz zaved in Plat Editor O from pottfolio saved in data et

@' fram your defautt portfolic

Crverride plotter saved in Plot Editar:

CURPLOT = hp Lazerdet 1300 PS w |
l O l l Cancel l l Help l
Figure2.2

The main part of this manual consists of a detailed description of the second and
third option, the interactive and automated part of the Plot Editor, respectively.

2.2 Plotting the active ToPsPIN data window

The easiest way to plot adataset isto print the current ToOPsPIN datawindow. To do
that:

1> enter pr nt on the command line
select the Printer and Paper Size and Orientation as requested and click OK.
The current dataset will be plotted exactly asyou see it on the screen, including:
 the selected region and intensity scaling
« displayed components on the screen like title, integrals, peaks labels etc.
e multiple display (if the data window isin this mode)
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« display of overview spectrum (if switched on)
See Figure 2.3.
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Assuch, you must set up set up the TopspIN data window according to your needs,
before you start printing. Exercise 1 isan example of how to do that.

Exercise 1
1. Open alD dataset.

2. Select acertain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

3. Adjust the vertical scaling. To do that click-hold the = button of the tool-
bar and move the mouse.

4. Display the desired dataset components like title, parameters, integrals etc.
To do that right-click in the data window, choose Display Options, enable
the desired components and click OK.

5. Enter pr nt onthe command line, choose the printer from the appearing
dialog, click OK, select the paper size and orientation and click OK.

The spectrum will be plotted and should be an exact representation of the datawin-
dow.

The command pr nt can be used for data of every processing status and data
dimensionality, e.g. it can be used for raw or processed 1D, 2D and 3D data. Note
that the command pr nt can aso be started from the print dialog, which is opened
by Ctrl +porprint.

2.3 Interactive plotting using layouts

Whereas the command pr nt can be used for simply printing the current data win-
dow, the command pl ot isfar more versatile. It opens the Plot Editor, an interac-
tive object-oriented editor in which you can preview, modify or create
sophisticated plot layouts. This allows you to determine the exact size and position
of the plot components, add graphics, plot multiple spectra on one paper and many
other things.

Plot Editor can basically be used to:
e preview the current plot layout before plotting
« modify an existing layout to your needs
e create anew layout from scratch

These three possibilities are described in the paragraphs bel ow.
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2.3.1 Preview and plot

The simplest way to use the interactive Plot Editor isto preview the plot of the cur-

rent dataset and then print it. The exercise below is an example of this.

Exercise 2

1
2.

Start TopPsPIN and open the dataset examld _1H/1/1.

Select a certain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected, see Figure 2.4).

Layout file for 'autoplat’

LAYOUT = 1D _Hoawp |

Figure2.4

Enter pl ot . The Plot Editor interface will appear, showing the selected
spectral region according to the layout 1D_H.xwp (see Figure 2.5).
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R e i

Figure 2.5

5. In the Plot Editor interface D:

a) Click File— Print[Ctr | +p] (see Figure 2.6), select the desired printer
in the appearing dialog and click Print.

The plot on the paper should be the same as the white areain the Plot Ed-
itor interface.

£ TOPSPIN Plot Editor - [1D_H.xwp]
] Fle Jedit Wiew TOPSPIN Options

Dﬁn%

Data ‘ Attributes| ZDDmin‘
Figure 2.6

b) Click File — Exit to leave the Plot Editor.
Note that the chosen plot layout (1D_H.xwp) does not show the peak labels. To

1) Not the ToPsPIN interface
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include the peak labels, repeat the above exercise, choosing the layout
1D_H+pp.xwp.

In this paragraph, we simply took the chosen layout asit is, and used the Plot Edi-
tor to preview and print the data. In the next paragraph we will see how to modify
alayout and then print it.

2.3.2 Modify alayout and print it

In this paragraph we will have acloser look at a plot layout, make a few basic
modifications and then print it.

Exercise 3
1. Start TopsPiN and open the dataset examld_1H/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

3. Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected).

4. Enter pl ot . The Plot Editor interface will appear, showing the dataset
according to the layout 1D_H.xwp (see Figure 2.7).

This layout contains 4 objects.
e aSpectrum object at the lower |eft
e aParameters object at the right (marked in Figure 2.7)
e aTitleobject at the upper left
e alogo object at the upper right

5. Just move the blue crosshair cursor around in the layout window and see
how each object is surrounded by a bounding box when the cursor isinside
of it (in Figure 2.7 this is the Spectrum object).
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D.Hgg'jn O
(il

et Frer e e

Figure 2.7

6. Now let's perform some basic operations with these objects:

 Mark an object:
Click the Mark Compl ete button:

oo o] @ theupper left of the Plot Editor interface, then click the ob-
B ject. The object will be surrounded by green markers (see the
o o| Parametersobjectin Figure2.7).

Move an object:
Click-hold the object, move the mouse and release it at the desired posi-

tion.

e Resize an object:
Mark the object (see above), click-hold one of the green markers, move
the mouse and release it when the desired size has been reached.

e Delete an object
Mark the object (see above) and click the Delete button in the command

bar or pressthe Del et e key on the keyboard.
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e Undo last operation(s)
Click the button Undo at the right of the command bar or pressCt r | +z.
Repeat this action if you want to undo multiple operations.

In the step 6 we have performed some operations on an object asawhole. In the
next stepswewill takeamore detailed |ook into an NMR object, like a Spectrum,
Parameters or Title object and modify aspects of it.

7. First we'll expand the spectrum and play around the expanded area.
a) Click the following icon:

+ | toswitch to expansion mode (see how the M odefield at the left
I of the Plot Editor interface is updated).

Expand

b) Click-hold in the Spectrum object, drag the cursor to create a box around
the desired spectral area and rel ease the mouse. See how the chosen area
is expanded.

¢) Click the Undo button in the command bar to undo the expansion.

Note that the Expand iconisonly applicableto Spectrum or FID objects, where-
asthe Zoom icon appliesto the entire layout area. A spectrum can also be ex-
panded from the 1D/2D-Edit or Edit dialog (see step 8 and 9).

8. Right-click in the Spectrum object and choose 1D/2D-Edit from the popup
menu.Thiswill open the dialog shown in Figure 2.8. In the upper part of this
dialog, you can set the Scope of dialog functions, Spectrum, Integral or
both.

a) Usetheiconsin the upper part of the dialog to move or expand the spec-
trum. Note that someicons must be clicked to perform the corresponding
action, whereas for other icons you have to click-hold and move the
mouse. Observe the effect of each action on the Spectrum object.

b) Click the various check buttonsin the middle part of the dialog to select/
deselect axes, grids, peaks and/or integrals. Observe the effect of each
action on the Spectrum object.

¢) Click Closeto close the dialog.
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Edit Display Object g

Scope: W Spectrum I Inteqral
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/8
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Figure 2.8

9. Right-click in the Spectrum object and choose Edit from the popup menu.
Thiswill open the dialog shown in Figure 2.9. At the top of the dialog you
see severa tabs with the Graph tab selected. Each tab gives access to the
corresponding dialog pane.

Spectrum] Data Set] B azic I

Flot
Hmin X 11.003050 -1.008057
min / Ymas Sra2451.870549 S | 16044272, 781524
[ Scale Bounding Box [ Diraw Box around

Figure 2.9
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a) Expand the spectrum by entering the exact limits of a certain spectral
region, in the fields Xmin/Xmax of the Plot section of the dialog.

b) Click OK to store the changes and close the Edit dialog.

Note that the Edit dialog allows you to set various other things, like axis
units, peak and integral labels (1D Spectrum pane), the dataset (Dataset
pane) and the object position and dimension (Basic pane).

Whereas in the previous steps, we worked with the Spectrum object of the plot
layout, we will now go to the Parameters object, which is atext object.

10.Right-click in the Parameters object of the layout and choose Edit from the
popup menu. Thiswill open the dialog shown in Figure 2.10. Asyou seethe
Text paneis selected.

arameter] Data Set] Bazic ]

Text

I Allova automatic font resize Edit ...

Figure 2.10

a) Click the Edit... button in the Text section. A text editor will appear
showing thelist of parameters. Just add, delete or modify any parameters
you wishY). Click the Close button to store the changes and close the dia-
log.

b) Select the Basic pane. The dialog will now show the object position and
dimension (see Figure 2.11). Enter the desired X and Y position and

1) Note that function of the Plot Editor isto display/plot datasets, not to modify them. This means
changesin parameters are not transferred to the ToPSPIN data window nor are they stored in
the layout or dataset. The original parameters are restored if you update the data from the
dataset (menu TOPSPI N).
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dimension of the object in, cm, relative to the plot area origin (the lower
left corner of the gray dashed box).

Tewt | Parameter | Data Set Basic l

Eosition '3 w 0.000000
Limengion W | h.200000 " | 16.200000
Attributes
Figure2.11

¢) Click OK to store the changes and close the Edit dialog.

Note that the Edit dialog offers different tabs for different objects. All objects,
however, NMR and Sandard, offer the tab Basic and all NMR objects offer the
tab Data Set.

4 Click Undo (repeatedly) to undo any undesired changesin the layout

Now let’s plot the layout that we have opened and modified.

11.Click File— Print [Ct r | +p] to print the layout. The printout on paper
should be exactly the same as the white area in the layout area.

12.Now save the new layout for later usage: click File — Save As... enter a
filename and click Save.

13.Click File — Exit to leave the Plot Editor.
In this paragraph we have opened, modified, printed an existing 1D layout, and

stored it under a new name. In the next paragraph, we will not use an existing lay-
out but create a new one from scratch.

2.3.3 Create a new layout

In this paragraph we will create a new Plot Editor layout from scratch. We'll start
with an blank layout area, insert NMR and Standard objects and, finally, print the
layout.
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Exercise 4

1
2.

Start ToPsPIN and open the dataset examld_1H/1/1.

Enter pl ot . The Plot Editor interface will appear, showing whatever layout
is defined by the parameter LAY OUT.

Click File —» New
A new empty layout will appear.?

Enable radio button NMR at the left of the Plot Editor interface (if it is not
aready enabled, see Figure 2.12).

" Btandard

Figure 2.12

Now we'll start filling the layout with objects using the icons at the left of the
Plot Editor interface.

5. Click the 1D Spectrumicon:

Place the cursor in the layout area at the desired position. Click-
hold and move the mouse to draw the Spectrum object and release
the mouse.

Click the Title icon:

Place the cursor in the layout area at the desired position and click
Title the mouseto create the Title object.

Click the Parameters icon:

Place the cursor in the layout area at the desired position and click
the mouse to create the Parameters object.

i

L
11

Enable the radio button Standard at the left of the Plot Editor interface (if it
is not already enabled, see Figure 2.12).

. Click the Circle icon:

1) Note that the original layout is, under a Windows operating system, still available under the
Window menu. Under Linux, the original layout is replaced by the new layout.
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Place the cursor in the layout area at the desired position. Click-
hold and move the mouse to draw the circle object and release the
mouse.

10.Click File— Print [Ct r | +p] to print the layout. The printout on paper

should be exactly the same as the white area in the layout area.

11.Now save the new layout for later usage: click File — Save As..., enter a

filename with the extension .xwp and click Save.

12.Click File — Exit to leave the Plot Editor.

2.3.4 2D Data

The interactive creation of a 2D plot is basically the same as the creation of a 1D
plot. The Plot Editor uses the Topspin data window plot limits and contour levels.

Exercise5

1
2.

Start TopsPIN and open the 2D dataset exam2d_HH/1/1.

Select a certain spectral region. To do that, click-hold in the data window
and drag the mouse to draw a box around the desired region.

Adjust the contour levels. To do that click-hold the = button and move
the mouse. Click the =] button to save the contour levels.

Click the s toolbar button to display the projections (if these are not dis-
played yet).
Right-click in the data window, inside the F1-projection area, choose Exter-

nal Projection from the popup and specify the dataset examld 1H/1/1 as
external projection. Repeat this action for the F2-projection area.

Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 2D_inv.xwp (if it isnot already selected).

Enter pl ot . The Plot Editor interface will appear, showing the layout
2D _inv.xwp with four objects (see Figure 2.13).

Asyou see, the 2D Spectrum object is displayed with one projection only, the
horizontal one at the top. As afirst step to modify the plot layout, we'll add the
vertical projection at the left.
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Figure 2.13

8. Right-click inthe 2D Spectrum object and choose Edit from the popup. In

the appearing dialog (see Figure 2.14):

Graph] 20 Spectiu Projections | [ikta Set] B azic ]

Data Setsz

v Top

| Bottom

Size

ﬂﬂ

Figure2.14

a) Click the 2D projectionstab.

b) Inthe section Data Sets, select the entry Left and click the Select... but-
ton to the right of this entry. Thiswill open the Data Set Selector.

Select .
Q

Q
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¢) Inthe Data Set Selector: click the 1D dataset to be used as vertical pro-
jection.
d) Click OK to closethe Data Set Selector and click OK to close the Edit
dialog.
9. Resize the 2D Spectrum object such that the left projection fits within the
plot area, (the gray dashed bounding box).

Note thiswas just an exercise.The result, alayout with a2D Spectrum object
with 2 projections, is available as the standard layout 2D_hom.xwp.

Now let’'s expand the spectrum and play around with the expanded area.
10.Click the Expand icon at the upper |eft of the Plot Editor interface;

. click-hold in the 2D Spectrum object and drag the mouse to create
+1* abox around the desired spectral area.

-

Expand

11.Right-click in the 2D Spectrum object and choose 1D/2D-Edit. Try out the
various display toggles and buttons in the appearing dialog. For example:

a) Click-hold the following button:

and move the mouse up/down and | eft/right to shift the expanded
0 area.

b) Click-hold the following button:

- and move the mouse to change the contour levels.

h 4
¢) Click Closeto close the 1D/2D-Edit diaog.

12.Click File— Print [Ct r | +p] to print the layout. The printout on paper
should be exactly the same as the white area in the layout area.

13.Now save the new layout for later usage: click File — Save As..., enter a
filename with the extension . xwp and click Save.

14.Click File — Exit to leave the Plot Editor.
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2.4 Handling datasets and portfolios

Plot Editor organizes NMR data in datasets and organizes datasets in portfolios. A
Portfolio consists of alist of available data directories and alist of selected data-
sets, in those directories. The dataset list is also called the Data Set Selector. The
following exercise allows you to familiarize yourself with the main aspects of the
Portfolio and Data Set Selector.

Exercise 6

1
2.
3.

Start ToPsPIN and open the dataset examld_1H/1/1.
Enterwr p 2, w p 3 and wr p 4 to copy the datato PROCNO’s 2, 3 and 4.

Enter nm to negate dataset examl1d_1H/1/1 (just to be able to distinguish it
from PROCNO 2,3 and 4)

Enter edc 2 and specify procno 2 and 3 as the second and third dataset,
respectively.

Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D+1D+1D.xwp.

Enter pl ot . The Plot Editor interface will appear, showing three 1D Spec-
trum objects above each other.

Move the cursor through the three 1D Spectrum objects and look at the sta-
tus line to see which object holds which dataset.

4@ Each object holdsa number that refersto a position in the Data Set Selector

8.

Click the Data button of the command bar to open the Data Set selector (see
Figure 2.15).

@ Thecurrent dataset fills/replacesentry 1in the Data Set Selector

@ The 2"9/3'd dataset (if defined) fill/replace entry 2/3 in the Data Set Selector

9. Click Edit in the Data Set Selector dialog to open the Portfolio Editor.
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Data Set Selector | |

E3

1: C:/Bio/data/guest/nmirfexarnld 1H/1/pdatas
2 C./Binsdatalguest/nmnfexam1d_THA Apdatals
3 C:/Bin/datasguest/nmrfexamld_TH /pdatas3

Apply

ok
_torb |
_ Gencdl |

LCancel

Figure2.15

10.1n the Portfolio Editor:

a) Select dataset examld 1H/1/4, click Append to add it to the Portfolio
field.

b) Click File— Save as.., enter afilename in the appearing dialog and click
Save to store the portfolio.

11.Click Apply to load the Portfolio list to the Data Set Selector.

Note that the Data Set Selector now contains at |east 4 dataset entries.

12.Mark the lower Spectrum object, click the entry of dataset examl1d 1H/1/4
in the Data Set Selector and click Set.

13.Move the cursor through the tree Spectrum objects and see how the dataset
in the lower object has been replaced by exam1d 1H/1/ 4.

14.Click File — Save Layout/Portfolio To Dataset.
15.Click File — Exit to leave the Plot Editor.

In step 14, both the current layout and portfolio are saved in the current dataset
PROCNO Y.

16.1n TopsPIN window, right-click in the data window and choose Files.. from
the popup menu.

17.Select the file Por f ol i 0. por and click Open to see the contents of the
file.

1) Infact, they are stored in the dataset specified at the first entry of the Data Set Selector.
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2.5

Note that during startup, pl ot first loads the default portfolio and then replaces
this with the portfolio in the current dataset PROCNO (if it exists). The latter
alows you to have al required information available to reproduce the same plot
later.

Plotting in automation using layouts

251

NMR data are often acquired, processed and plotted in automation, with AU pro-
grams or with the program |CON-NMR. Plotting in automation uses the same plot
layouts and portfolios used by the interactive Plot Editor. Layouts can be standard
Bruker or user-defined layouts.

Plotting in ICON-NMR

ICON-NMR is the standard program for automated spectroscopy. It uses predefined
experiments (parameter sets) to measure data of series of samples. Furthermore, it
uses AU programs to acquire, process and plot these experiments. Processing and
plotting are executed by the same AU program. An example of such an AU pro-
gramisproc_1d,whichisused in many 1D experiments. AU programs plot data
by executing plot macros, the main one being AUTOPLOT. This macro executes
the aut opl ot command which plots the current dataset according to the current
plot layout. The AU program and layout used for plotting are defined by the exper-
iment parameters AUNMP and LAY OUT, respectively.

In the following exercise we'll manually step through the processing/plotting part
of IcoN-NMR from the TopspiN command line. We'll start with an acquired dataset
containing raw data.

Exercise 7

1. Open the dataset examl1d_1H/1/1.

2. Enter aunnp. Thiswill show you the value of the parameter AUNMP, the
AU program used for processing/plotting (normally pr oc_1d). Click Can-
cel to close the dialog.

3. Enter | ayout . Thiswill show you the value of the parameter LAY OUT,
the layout that is used for plotting (normally 1D-H.xwp). Click Cancel to
close the dialog.

4. Enteredau proc_1d toopenthe AU program. Just scroll through the
text and see the processing macros like EF, APKS etc., and, at the end the
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plot macro, AUTOPLOT.
5. Click File — Close to close the AU program.
6. Enter pr oc_1d to execute this AU program.

Watch the ToPSPIN statuslineto see the successive processing commands be-
ing executed. The last command isaut opl ot , as executed by the AU mac-
ro AUTOPLOT, which plots the dataset.

Note that in ICON-NMR automation, all of this is done automatically. Furthermore,
ICON-NMR allows you to control plotting in the following ways:

« Disable plotting (see ICON-NMR Configuration).

e Create PDF or Postscript output in the dataset PROCNO directory, in addi-
tion to a hardcopy printout (see ICON-NMR Configuration).

« Use your own layouts with your own experiments (see ICON-NMR Setup
Manual).

« Useyour own layouts with Bruker Experiments, by setting the layout search
path (see also paragraph 7.2)

2.5.2 Reset actions

Aswe saw in the previous paragraphs, interactive plotting is performed by the
command pl ot and automated plotting by aut opl ot (inform of the AU macro
AUTOPLOT). Both commands use a Plot Editor layouts but there is one important
difference:

e pl ot usesthe plot region and intensity scaling of the ToPSPIN data window
(parameters F1P/ F2P and CY) for all Spectrum objectsin the layout D,

e aut opl ot performsthe so-called Reset Actions; a set of rules, which con-
trol the plot region, intensity scaling and baseline position of individual
Spectrum objects.

Note that this behaviour can be manipulated with arguments: pl ot - r performs
Reset Actionsand aut opl ot - f doesnot perform Reset Actions. Furthermore,
after opening the Plot Editor interface with pl ot , you can reset individual objects
by right-clicking in the object and choosing Reset Object.

€ Reset actions control Expansion, I ntensity scaling and Baseline offsets

1) Note that one layout can have multiple Spectrum objects.
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Reset Actions either use or overrule experiment parameters. Let's see how this
works.

Exercise 8
1. Open the 1D dataset examld 1H/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

3. Enter | ayout onthe command line. Inthe appearing dialog, select the
standard layout 1D_H+zoom.xwp.

4. Enter aut opl ot to plot the spectrum with Reset Actions.
5. Enteraut opl ot -f to plot the spectrum without Reset Actions.

The effect of the Reset Actionsis clear from the difference between Figure 2.16
and Figure 2.17. The lower object in Figure 2.17 shows the full spectrum instead
of the selected region, the intensity of the upper object is scaled down

A “w ¥ LIM_

T T
3?- 3' 33 3» 34333 T T '6 T4 '. .'.i'l'lil 33

L

T T T
33 3' 33 $-a- 3-1- 333 $I $I:I .'.3 7 .'..' T.B '.6 '-1- T2 ""'I IZI$$ ppm

Figure 2.16 Output of aut opl ot -f (no Reset Actions)
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N
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33 3' 3& $o 3-1- 33 3‘ $I $I:I .'.3 7 .'.6 '-1- '3 F2FA1 TO BE ppm

Lol i

w s s 7 8 & 4 & 12 T8 pem
Figure 2.17 Output of aut opl ot (Reset Actions)

To understand how this works, we will look at and perform the Reset Actions for
each object separately.
6. Enter pl ot to show to open the Plot Editor without Reset Actions. The lay-
out looks like the output of aut opl ot - f (seeFigure 2.16).

7. Right-click in the upper Spectrum object and choose Automation to look at
the Reset Actions. note that size of biggest peak is set to 100% (see Figure
2.18). Click OK to close the Automation dialog

Alter rezet, size of biggest peak iz
f+ 10000 ¥ ofplotsize ¢ 10,00 cm

" defined by pararneter C [in cri)

Figure2.18

8. Right-click in the upper Spectrum object again and choose Reset Object to
execute the Reset Actions on this object. See how the intensity is scaled
down V) (see the upper part of Figure 2.17).

9. Right-click in the lower Spectrum object and choose Automation to look at
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the Reset Actions: note that Xmin/Xmax is set to minimum/maximum (see
Figure 2.18). Click OK to close the Automation dialog.

Rezet action for #mind<mas

" Don't change

7 Sgt bo minimunmaximum

Figure 2.19

10.Right-click in the lower Spectrum object again and choose Reset Object to
execute the Reset Actions on this object. See how the displayed region
changes to full spectruml) (see the lower part Figure 2.17).

Note that in this exercise only one Reset Action is considered for each object. All
other Reset Actionsin the Automation dialog are also executed but do not change
the object.

2.5.3 Plottingin AU programs

Plotting in an AU program is performed with the macro AUTOPLOT, which calls
the command aut opl ot .

Exercise 9
1. Open the 1D dataset examld 1H/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

3. Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected).

4. Enteredau ny_pl ot _au
5. Inthe appearing editor, enter the following two lines:

AUTOPLOT
QUIT

save and quit the editor.

1) Without Reset Actions, the biggest peak defaults to the value of CY.
1) Without Reset Actions Xmin/Xmax defaults to F1P/F2P
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2.6

6. Enterny_pl ot _au

The AU program is compiled 1 and then executed, plotting the current data-
set according to the chosen layout.

Notethat thisisatrivia example of an AU-program, which does the same as
entering the command aut opl ot ion the command line.

Bruker AU programs use the AUTOPLOT and various other macros to plot data.
Pleaselook at the AU programs pr oc_1d or pr oc_2di nv for more examples.

I mport/Export

2.6.1

2.6.2

PLOT EDITOR supports full import and export of graphics. Graphics can be
imported into the Plot Editor in form of EMF or WMF files (Windows) and in
form of EPSI files (Linux). Graphics can be exported to graphics formats such as
EMF, PS, PNG etc. and to the Clipboard. Export can be performed, interactively,
from the Plot Editor interface or, automatically, from the command line or from an
AU program.

Importing graphics and text

Graphics can be imported as areference to an external graphicsfile or as an inter-
nal graphics object. In the first case, you have to create a Sandard Meta object
(Windows) or EPSl object (Linux). Then double-click the object, to open the Edit
dialog, and browse for the graphicsfile. In the second case, you first have to open
the graphics file (with any graphics program), copy it to the clipboard and then
pasteit to the Plot Editor.

Importing text

To import text from atext file to aplot layout, you have to create an NMR Text
object. Then double-click the object to open the Edit dialog and browse for the text
file. Alternatively, you can import text by copying it from any application to the
clipboard and then paste it to the Plot Editor.

1) An AU program is automatically compiled on first usage.
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2.6.3 Exporting Graphicsunder Windows

PLoOT EDITOR alows you to export the layout area to various graphics formats like
EMF, PS, PDF and PNG as we as copy it to the Clipboard. Exported files can be
imported by other applications. PNG is usually a good choice for these applica-
tions. Copying to the Clipboard allows you to copy single objects as opposed to the
entire layout area.

€ PNG format is highly recommended for exporting Plot Editor graphics

PDF can be used to print the graphics on computers on which Plot Editor is not
installed.

A plot Editor layout can be exported in several ways.

From the Plot Editor Interface:

e Click File » Export, enter the filename, format and (if requested) the sam-
pling rate (default 360).
e Click File > Send to send the layout by email.
e EnterCtrl +a, Ctrl +c tocopy all objectsto the clipboard. Then paste
them to any other application.
From the TopspiN command line:
e Enteraut opl ot -e <pat hname> . For example:
autopl ot -e C \TEMP\ny_pl ot. png. g
e Writean AU program (with edau) containing the following statement:

AUTOPLOT_TO_FILE("<pathname>")

2.7 Setting thetarget printer

By default, the commands pl ot and aut opl ot usethe printer defined in the
layout or, if this printer does not exist, the system default printer. You can, how-
ever, override thiswith the printer defined by the processing parameter CURPLOT
by using the - ¢ argument, i.e. entering pl ot - ¢ or aut opl ot - c.

1) Note that the format of the graphics output file is determined by the file extension.
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Chapter 3
The Plot Editor

3.1 Introduction

TopsPIN PLOT EDITOR isafully object-oriented, interactive WY SIWY Gl plot edi-

tor for high quality printouts of your data. It resembles other well-known drawing
programs in many ways and, as such, it is easy to use.

Before we describe the Plot Editor functionality, let’s define afew things.

I nterface

The Plot Editor interface is awindow which consists of alayout area, a menu
bar, an icon bar, atoolbar, acommand bar and a status line. The interfaceis
opened with the command pl ot . From here, you can view, display, modify or
create plot layouts, fill them with spectral data and print them.

L ayout

A layout isatemplate, which definesa number graphical objectswhich can be
Sandard graphics or NMR objects. One layout can be used for different data-
sets, and, vice versa, a dataset can be plotted with different layouts. A layout

isdefined by the processing parameter LAY OUT, which can be set by clicking

1) ,What You See |s What You Get*
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the Procparstab or entering edp and then select Automation, or by entering
| ayout onthe command line. Layouts are stored in files with the extension
. Xwp. TopspIN isdelivered with alarge set of layoutsfor various standard 1D
and 2D experiments. User-defined layouts can be created and stored for |ater
usage. A layout does not contain spectral data.

Objects

An object isagraphical element of alayout. Objects can be NMR objectslike
Spectrum, FID, Parameters, Title etc. or Sandard objects like lines, squares
curves etc. Each object hasits own position, size, attributes and properties.
Each NMR object has its own Reset Actions.

Datasets

A dataset holdstheactual NMR data, i.e. the FID and/or spectrum. It isdefined
by adirectory with several files, each of which contains a part of the dataset
likethefid, the spectrum, the parameters, thetitle etc. Plot Editor displayseach
part of the dataset in a separate NMR object.

Portfolios

A Portfolio consists of alist of available datadirectories and alist of selected
datasetsin those directories. The dataset list is also called the Data Set Sel ec-
tor. It allows you to assign datasets to NMR objects. The current Portfolio can
be made the default portfolio and it can be stored with the current dataset.

The use of objects, layouts and portfolios make Plot Editor aflexible and versatile
tool. One layout can be used with different portfolios to create the same view/plot
of different datasets. Similarly, one portfolio can be used with different layouts to

create different views/plots of the same dataset(s).

3.2 Sarting the Plot Editor

The Plot Editor is started with the command pl ot . This command:
e usesthelayout defined by the parameter LAY OUT
e usesthe expansion (limits) Dand intensity scaling of the data window

1) Note that the command plot stores the displayed region in the parameters F1P/F2P.
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321

322

¢ shows the current dataset

Thisiswhat happensif pl ot isentered without arguments, and LAY OUT defines
alayout for one dataset only, like 1D_H.xwp.

However, the command pl ot takes various arguments, and layouts can define
multiple datasets. These features are described bel ow.

Layout handling

Thecommand pl ot opensthe plot Editor interface according to the current layout
as defined by the parameter LAY OUT.

In order to use a different layout, use one of the methods bel ow:

1 Enter | ayout onthe command line, select the desired layout, click OK.
Then enter pl ot .

or
i Enter pl ot <l ayout >

where <| ayout > isthe pathname of the layout file.

Expansion and intensity scaling

The Plot Editor can be started with or without Reset Actionsto control expansions,
intensity scaling and baseline positions.

To start the Plot Editor using the dataset window settings:
1= enter pl ot

Expansion limits and intensity scaling are taken from the TopspIN data win-
dow (parameter F1P/F2P and CY).

To start the Plot Editor with Reset Actions;
= enter pl ot -r

Expansion limitsand intensity scaling are set according to the reset action as de-
fined in the layout for each individual object.

To start the Plot Editor as defined in the layout:
1= enter pl ot -n

Expansion limits and intensity scaling are taken from the layout for each Spec-
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trum object.

3.2.3 Portfolio handling

Although the Plot Editor normally shows a layout with one dataset, the current
dataset, it can do much more than that. Plot Editor can use layouts defining multi-
ple datasets, which are organized in a portfolio. Here is what actually happens
when you enter the command pl ot .

1. Plot Editor loads the default portfolio, which isthe portfolio last saved from
the Portfolio Editor with File - Save As Default. If this has never been
done, Plot Editor uses the same default portfolio as the Topspin browser.

2. Plot Editor replaces the portfolio loaded in step 1 by the portfolio in the cur-
rent dataset PROCNO, if this exists V.

3. Plot Editor replacesthefirst entry in the Portfolio Data Set Selector with the
path of the current dataset.

4. Plot Editor replaces the second and third entry in the Portfolio Data Set
Selector with the path of the second and third dataset, respectively, if these
are defined (e.g. with the commands edc2 or pr oj d).

5. Plot Editor connects each NMR object in the layout with the associated data-
set. Note that each object has anumber which corresponds with apositionin
the Portfolio Data Set Selector.

This may look alittle complicated but normally it is very simple; Plot Editor
shows the current dataset according to the current layout. The above portfolio han-
dliing only plays arole for layouts that define multiple datasets like the 1D layouts
1D+1D+pp.xwp and 1D+1D+1D.xwp and the 2D layouts 2D_hom.xwp and

2D _inv.xwp.

To open the Data Set Selector:
1> Click the Data button of the command bar
To open the Portfolio Editor:
1= click Edit in the Data Set Selector dialog (see Figure 3.1)

1) It can be stored from the Plot Editor with File — Save Layout/Portfolio to
Dataset.
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Data Set Selector gl
1: C:/Bin/datas guest/mmrfexam1d 1HA Apdata i)
2 C:/Bin/data’guest/nmrfexamd_1HM /pdata/2 Q

3 C:/Bin/datasguest/nmrfexamld_TH /pdatad3 Apply

Lancel

|
Sl

Figure 3.1
The use of portfolios can be further controlled with command line arguments:
pl ot -i
Ignore a possible portfolio in the dataset PROCNO (see step 2 above)
plot -p <portfolio>
Starts the Plot Editor with the specified portfolio, e.g.:
plot -p C\pf\nypf.port

3.2.4 Sartup for 2D data

On 2D datasets, Plot Editor is usually started in the same way as on a 1D dataset,
with the command pl ot . Besides the 2D spectrum, the plot layout also shows
projections which must be defined first, as separate 1D datasets.
Exercise 10

1. Open a2D dataset.

2. Enter the command pr oj d. In the appearing dialog select Display 1D spec-
tra along with the 2D spectrum and specify the 1D spectra to be plotted as
projections.

3. Enter | ayout onthe command line. In the appearing dialog, select an
appropriate 2D layout.

4. Enter pl ot .
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5. InthePlot Editor interface, right-click inthe 2D Spectrum object and choose
Edit from the popup menu.

6. Inthe appearing dialog (see Figure 3.2)

Graph ] 20 Specta Set] B azic ]

Data Setsz

v Top  Siee 3.00 Select ...

<D

VL e 200 seka |
[ Right Q

Figure 3.2

a) Click the 2D projectionstab.

b) Inthe section Datasets, enable the entry Left and click the Select... but-
ton to the right of this entry. Thiswill open the Data Set Selector (see
Figure 3.3).

¢) Inthe Data Set Selector: select the dataset to be used as vertical projec-
tion. Click OK to close the Data Set Selector and click OK to close the
Edit dialog.

Data Set Selector | |

1: C./Bin/datasguest /nmnfexam2d_HCA Apdatal
2 C:/bio/datadquest/nnr/examld THA /pdatadl

E3

3 Co/bioddatadguest/nmr/examld_13C1 Apdatal

& >

Apply

LCancel

Edit

A

Figure 3.3
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Note that you can also use the command edc 2 to define the second and third data-
set in the Data Set Selector, before you start the Plot Editor.

3.3 ThePlot Editor interface

The Plot Editor interface is opened by the command pl ot . All Plot Editor opera-

tions, like, storing and printing layouts are done from here.
menu bar tool bar command bar title bar

( = rorseinpie cditor - [1D_H.xwp]

[N}

Edit | 1D/zD-Edit ‘ Und_u>|

< Data ‘ Attributes| Zoom in |ZUDmDut| Full ‘ Delete ‘ | FRotate

o =} =}

1H Cyclosporin m

D meMh

T
9

o

T 1
4 o ppm

e Erer o e

For Help, pres¥ F1 Mark ohiject ‘\ Zoom: 100 % 3
| ™~ |
toolsarea status line layout area

The Plot Editor interface consists of the following parts:

e Layout Area: the largest part of the interface, containing all the objects
to be printed. The white part of the layout area corresponds to the paper
sheet. The grey dashed bounding box indicates the plot area.
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* ToolsArea: at the left, with the Selection and Expand icons, the Sand-
ard/NMR radio buttons, the Graphics creation icons and the Mode field.

¢ Menu: Standard pull-down menus like File, Edit etc.
e Command Bar: frequently used object and other commands
e Toolbar: frequently used layout and other commands

e Satusline: shows the cursor position and, for NMR objects, the associ-
ated dataset

3.3.1 TheLayout Area

The Layout Area contains all the objects to be printed. The white part corresponds
to the paper sheet. By zooming in or out, using the Zoom in and Zoom out buttons
of the command bar, the white part can become larger or smaller than the layout
area. If you zoom in far enough, the white part will exceed the window size and
scroll bars will appear at the right and at the bottom, allowing you to scroll to any
part of the layout.

The gray dashed box indicates the plot area of the current paper format (see Figure
3.4). Objectsthat are completely outside of thisbox will be not be printed. Objects
that are partially outside of the bounding box will be clipped.

Right-clicking any object in the layout area opens a popup menu with several func-
tions.

3.3.2 TheTools Area

The Tools Area contains the creation and control icons for creating and manipulat-
ing objects, respectively. Furthermore, it contains two radio buttons, which allow
you to toggle between Sandard and NMR object icons. Figure 3.5 shows the crea-
tion iconsfor Standard graphical objects. To create a Sandard object, just click the
respective icon, move the mouse into the layout area and click at the desired posi-
tion. For some objects, you have to | eft-click-hold and move the mouse to draw the
object (see also paragraph 5.5).
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Title Logo
object object

TS R / ““““““““““ gy o
18 cyclfeporin |
1

pése

O
T }
Spectrum — poundingbox  bounding box Parz?)r_neters
object plot area marked object object
Figure3.4

Figure 3.6 shows the creation icons for NMR objects. To create an NMR object,
just click the respective icon, move the mouse into the layout area and click at the
desired position. The required dataset is read from the Data Set Selector (Com-
mand Button Data). The graphics attributes are read from the Attributes sel ector
(Command button Attributes).
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At the top of the tools area, you find the following icons:

F

-

Sepand the spectrum.

¥ Switch to Expansion mode. In this mode, you can expand a part of
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To do that, click-hold in the spectrum object and draw a box around the desired
region.You can manipulate the expansion by drawing the box while pressing a
on of the following modifier keys:
e Shift -only the X- expansion is changed while the Y expansion
remains the same
e Ctrl -onlytheY-expansion is changed while the X expansion remains
the same
e Alt - blow uptheregion inside the box, according the Global Prefer-
ences in the Options menu (see Figure 3.7).

y, I“ N
M J‘.k k_/\_,m_ﬂd\,

T T T T T T T T T T
44 43 42 41 40 33 38 T ik Ppm

Figure 3.7

Switch to Zoom mode. In thismode, you can zoom in on any part of
Foonm thelayout.

To do that, click-hold in the layout area and draw a box around the desired part
of it. To display the full layout area, click the Full button of the command bar.

o,0 O

Switch to Mark Complete mode. Individual base point positions of
s o/ marked objects cannot be changed, only the dimensions.

o
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Switch to Mark Points mode. Individual base points positions of
| marked objects can be changed.

To mark one object:
1= click the object
To mark multiple objects:
1= click the objectsto be marked while pressing the Shi ft key
To mark all objects:
i PressCt r | +a
(see also paragraph 5.1 for more information on marking objects).

Figure 3.8 shows the Mode field which shows the current creation or control mode.

o,.o o
Mode: | =

Figure 3.8
The Mode field is adjusted when you click any of the iconsin the Creation Area.

3.3.3 TheCommand Bar

The Plot Editor command bar (see Figure 3.9) consists of anumber of large but-
tons for frequently used data, object and layout commands. Note that only rele-
vant buttons are active, e.g. the Group button is only active if two or more
objects are marked.

Data ‘ Attributes| Zoarm in ‘Zuamaut| Full ‘ Delete |

‘ | Fuotate ‘ Edit |1D,’2D—Edit‘ Undo |
Figure 3.9
The functions of the individual buttons are:
Data - Open the Data Set Selector/ Portfolio
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Attributes - Open the Attributes dialog
Zoom in - Zoom in the entire layout
Zoom out - Zoom out the entire layout
Full - Reset zoom; show the entire layout

Delete - Delete the marked object(s). Only active when one or more objects are
marked.

Group - Group the marked objects. Only active when two or more objects are
marked.

Ungroup - Ungroup the marked object(s). Only active when the marked object
isagrouped object.

Rotate - Rotate the marked object(s) 90° counterclockwise.

Edit - Open the Edit dialog of the marked object, showing various objects prop-
erties. Equivalent to double-clicking that object.

1D/2D-Edit - Openthe NMR edit dialog. Only activefor NMR data objectslike
1D Spectrum, 2D Spectrum and FID.

Undo - Undo the last operation. Can be used repeatedly to undo multiple opera-
tions. Only active when at least one operation has been done. Equivalent to

Ct r | +z. Undo only works for actions that change the layout. It does not work
on actions like changing the input mode or changing attributes for new objects
to be created.

3.3.4 The Toolbar

The Plot Editor toolbar (see Figure 3.10) consists of anumber of buttonsfor fre-
quently used layout and other commands.

D & &
Figure 3.10

The functions of the individual buttons are listed below. M ost functions can also
executed with control keys.

[ Createanew layout [Ctr | +n ]
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= Openalayout [Ctr] +0]

[d Savethecurrentlayout [Cir | +S ]
Save the current layout as...

% Cut the marked object(s) [Ct r | +x ]

&p Print the current layout [Ct r | +p ]

=, Multiprint
52y Copy the marked object(s) to the clipboard [Ct r | +c ]
2} Paste the clipboard contents to a new meta object [Ct r | +v ]

% Open the Help index

3.4 TheMenu Bar

The Plot Editor menu bar (see Figure 3.11) consists of anumber of pulldown
menus with all Plot Editor commands as well as Help documents.

File Edit  Wiew TOPSPIM  Draw  Ophions  Window  Help
Figure3.11

Thefollowing menus are available:

File

Layout file related commands like new, open, save, export, send and print. Fur-
thermore, commands for saving/opening the portfolio in the current dataset.
Edit

Object related commands like delete, cut, copy, paste, duplicate, mark, reset,

raise and rotate but also edit properties and tick settings. Furthermore, the undo
command.

Topspin
Commands to get or update the current dataset or run TOPSPIN commands.
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Options
Commands to set marker size, expand options and snap-in distance.

Window
Commandsto arrange multiple layouts. Only useful if you have two or more lay-
outs open (Windows only).

Help
The Plot editor manual, Tips and Version info.

3.4.1 TheFile menu

The File menu (see Figure 3.12) offers standard layout file related commands like
new, open, save, export, send and print.

File Edit wiew TOPSPIN Options  Window

[§= CHrl+M
Open... Ctrl+0
Save 45
Sawe As...

Ahandon

Cloze

Open Layout/Portfolio From Dataset, .,
Save Layout/Portfolio To Dataset, .

Export ..
Send ...

Prirt... 4P
Muti-Print ..
Page Setup...

Exit

Figure 3.12

Furthermore, the File menu contains the following functions;
Abandon Restore the last saved layout, discarding all changes.

Close: close the current layout, leaving the Plot Editor open including possible
other layouts.

Open Layout/Portfolio From Dataset: Open the layout and portfolio stored in
the current dataset PROCNO (if it exists).
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Save Layout/Portfolio To Dataset: Store the current layout and portfolio in the
current dataset PROCNO.

Close: close the current layout, leaving the Plot Editor open including possible
other layouts.

Multi-Print; Print multiple datasets with al open layouts.
Page-Setup: set up the paper size paper orientation etc.

Exit: exit the Plot Editor. You will be prompted to save open layouts.

3.4.2 The Edit menu

The Edit menu (see Figure 3.13) offers standard object related commands like
delete, duplicate, cut, copy, paste, mark, reset, raise and rotate.

Edit “iew TOPSPIN  Options  Window

Undo Ctrl+2
Delete Dl
Duplicate

Raize CHrl+R.
Lot CHrl+L
Rotate

Marlk: Al CHrl+2o
Unrnark 2 CErl+M
Cut 4+
Copy Ctrl+C

Reset Marked Ohjects Ctrl+T
Reset &l Ohjects

Ohject Properties ...
Automation Parameters ..,
&xis Tick Settings...

Figure 3.13

Furthermore, it contains the following functions:

Reset Marked Objects : Perform Automation Reset Actions on all marked ob-
jects.
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Reset All Objects : Perform Automation Reset Actions on all objects.

Object Properties...: Open the Edit dialog for the marked object. (same as dou-
ble-clicking this object, see paragraph 5.8)

Automation Parameters ...: Open the Automation Reset Action dialog for the
marked object (see Chapter 8).

Axis Tick Settings .... Open the Axis Tick Settings dialog for the marked object
(see paragraph 5.10).
3.4.3 The TOPSPIN menu

The TOPSPIN menu (see Figure 3.14) offers TopsPIN interface related commands.

TOPSPIM  Options  wWindow  Help

Get Current Data Set
Get Current Data Set + Reset
Get Current Data Set + Reset + Print

TOPSPIM Cornrmand Interface ... Ctrl+1
Update Data from Data Set Ctrl+D
Figure3.14

Here are the functions:

Get Current Data Set: Get the dataset from the current (active) ToPsPIN dataset
window). g

Get Current Data Set + Reset Get the dataset from the current (active) TOPSPIN
dataset window) and perform Reset Actions.

Get Current Data Set + Reset + Print: Get the dataset from the current (active)
TopsPIN dataset window) perform Reset Actions and print.

TOPSPIN Command I nterface: Open a dialog that shows the datasets in the
Data Set Selector and allows you to run TOPSPIN command on them.

Update Data from Data Set: Update all NMR objects from the TopsPIN dataset
window(s) 2.

1) Dataset is read to the spectrum object associated with the first entry of the Data Set Selector
2) Useful if data have been manipulated from the TopsPIN data window after the Plot Editor was
opened.
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View error messages. view error messages since Plot Editor startup.

3.4.4 TheOptions menu

The Options menu (see Figure 3.15) offers afew setup commands.

Options  Window  He

Global Setup ...
Layout Setup ...

Figure 3.15

Global Setup ...: Open adialog where you can change setting for all objects (see
Figure 3.16).

Global Preferences |

Ok

E

Marker
Apply

i

Cancel

Blowup Offzet 15
Elowup E=panzion 8.0

v Show Expanzion Label

Figure 3.16
Thefollowing functions are available:

Marker: Move the slider to set the size of the (green) markers of marked ob-
jects.

Blowup Offset: Set the offset of the Alt-Expand function; the distance be-
tween spectrum and expanded region (in cm)
Blowup Expansion: Set the Expansion factor of the Alt-Expand function.

Show Expansion Label: Enable/disable display of the expansion factor with
the expanded region created with the Alt Expand function.
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For more information on the Alt-Expand function, see paragraph 3.3.2.

Layout Setup ...: Open adialog where you can set the Snap-In distance. (see Fig-
ure 3.17)

Layout Setup

Shap-ln
= Hone
............. m
01 em 01 inch
05 em " D5inch m

" 1.0cm " 1.0inch

Figure 3.17

Now objects can only be placed/moved to fixed grid positions at the specified dis-
tance. This allows you to exactly align objects. When the Snap-In distanceis set
to none, you can smoothly move objects to any position in the layout.

3.4.5 The Window menu

The Window menu (see Figure 3.18) offers afew layout window related com-
mands

Window  Help

e Windo
Cascade

Til=

Arrange Icons

1 10 _H.xwip
v 2 Plotl

Figure 3.18
The following functions are available;
New Window: Open anew layout window.
Cascade: Arrange existing layouts in cascade.

Tile: Arrange existing layoutsin tile.



62 The Plot Editor

Arrangeicons;

<no> <layout>: select layout

3.4.6 TheHelp menu
The Help menu (see Figure 3.19) offers tips and help related entries.

Help
Tip of the Day...

Plot Editor Manual ...
Ahout TOPSPIM Plot Editor .,
Figure 3.19
The following entries are available:

Tip of the Day... : Show the Tip of the Day (can be set to appear during Plot Ed-
itor startup).

Plot Editor Manual... The manual you are currently reading.
About TOPSPIN Plot Editor... Version and license info.

3.5 The popup menu

Frequently used object related commands are available in aright-click popup
menu for quick access. If you right-click an object in the layout area, the object is
automatically selected and a popup menu appears (see Figure 3.20). L)

The functions of the right-click popup menu are:

Edit
OpentheEdi t dialogwith various objects properties. Equivaent to clicking the
Edit button or double-clicking the object.

1D/2D-Edit
Openthe NMR Edit dialog. Only activefor NMR dataobjectslike 1D Spectrum,
2D Spectrumand FID. Equivalent to clicking 1D/2D-Edit button.

1) On many Linux systems the popup menu will not work as long as the NUMLOCK state is acti-
vated on your keyboard. Press the NUMLOCK key to deactivate it.
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Edit ...
10/ 20-Edit ...

Automation ...

Axis Tick Settings...
Attributes .

Cut
Copy

Delete
Duplicate

Raize
Laonwer
Riotate

Reset Chiject

Figure 3.20 The popup menu

Automation
Open the Automation Reset Actions dialog D, Allows you to change the Reset
Actionsfor the current object. Requires a Reset Object for changes to take eff ect
(see below).

Axis Tick Settings
Open the Axis Tick Settings dialog. Allows you to change the axis tick settings
for the current object.

Attributes
Open the Attributes dialog. Equivalent to clicking the Attributes button.

Cut
Cut marked object(s) and place them on the Clipboard. Equivalentto Ct r | +x.

Copy
Copy marked object(s) to the clipboard. Equivalentto Ct r | +c.

Paste
Paste object from the clipboard. Equivalentto Ct r | +v.

1) Only active for NMR data objects like 1D Spectrum, 2D Spectrum and FID.
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Delete

Delete the selected object. Equivalent to clicking the Delete button or pressing
the Del et e key.

Duplicate

Duplicate the selected object. A copy of the object will appear slightly shifted
from the original one.

Raise

Raise the selected object to foreground. Equivalentto Ct r | +r.

L ower
Lower the selected object to background. Equivalentto Ct r | +l .

Rotate
Rotate the selected object 90°, counterclockwise.

Reset Object
Apply changes in the Automation Reset Actions on the selected object.

Please note that:

« functions where no equivalent is mentioned, like Automation and Raise are
also available from the Edit menu.

« theright-click popup menus only work on the selected (clicked) object,
whereas the command bar buttons and pulldown menus work on all marked
objects.

3.5.1 TheSatusLine

At the bottom of the Plot Editor interface, you find the status line (see Figure 3.21).
In the middle of the status line, you see the cursor position, and, if the cursor isin
an NMR object, the dataset associated with that object. In theright part of the sta-
tus line, you see the current creation or control mode, which corresponds to the
Mode field at the left of the Plot Editor interface. At the extreme right, the status
line shows the current zoom factor.

Position: 16.70,9.20 (C:/ts16/datafquest/nmrfexam1d_1Hf/1/pdatafly ...

Create parameter object Zoom: 0%

Figure 3.21
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3.6 Setting thetarget printer

By default, the commands pl ot and aut opl ot use the printer defined in the
layout. If, however, this printer does not exist, the system default printer is used.
Thismeansthat if you are using Bruker layouts such as 1D_H.xwp or

2D _hom.xwp, the system default printer will normally be used because the Bruker
defined printer in the layout does not exist on your system.

If you have more than one printer connected to your system, and do not want to use
the default one, you can use pl ot or aut opl ot with the - ¢ argument. In that
case, the printer defined by the processing parameter CURPLOT will be used.

Exercise 11
1. Start TopsPIN and open a 1D dataset of a proton spectrum.

2. Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected).

3. Enter cur pl ot on the command line. In the appearing dialog, select the
desired printer.

4. Enter pl ot - c. ThePlot Editor interface will appear.
5. Click File— Print

The printer that is selected in the print dialog isthe one defined in step 3.
6. Click the Print button in the dialog to print the layout.
7. Click File — EXxit to close the Plot Editor interface.

8. Enter aut opl ot - c to print the current dataset again on the selected
printer.

Notethat the target printer can also be selected from the print dialog opened by the
TopsPIN command pri nt [Ctr | +p].

The - ¢ argument is suitable for occasional usage of a printer other than the default
one. If you do thisregularly or want to print your data on two or more printers, you
might want to store you own set of layouts with the desired printer defined. The
follow exerciseis an example of you how can do that.

Exercise 12
1. Start TopsPIN and open a 1D dataset of a proton spectrum.
2. Enter | ayout onthe command line. In the appearing dialog, select the
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standard layout 1D_H.xwp (if it is not already selected).

3. Enter cur pl ot onthe command line. In the appearing dialog, select the
desired printer.

4. Enter pl ot -c. The Plot Editor interface will appear.

5. Click File— Save as... and select or enter the desired layout name, e.g.
1D _H_LJ4000.xwp.

6. Click File — Exit to close the Plot Editor interface.

7. Enter| ayout onthe command line. In the appearing dialog, select the lay-
out that you stored in step 5.

8. Enter aut opl ot to print the current dataset on the printer stored in the
selected layout

As such, you can define you own set of layouts for printing on any printer con-
nected your system. Note that you can also store your own layouts under their orig-
inal names but in a different directory (see paragraph 6.2).

For more information on setting the target printer in automation and on Linux sys-
tems, see paragraph 7.7 and 11.4, respectively.



Chapter 4
Datasets/Portfolios

TopsPIN and Plot Editor organize NMR data in datasets and organi zes datasetsin
portfolios. A dataset consists of a directory tree with various files, which contain
data components. A Portfolio consists of alist of available data directories and a
list of selected datasets in those directories. Thisway of organizing data makesthe
Plot Editor very flexible and versatile.

4.1 Dataset structure

A dataset holds the actual NMR data, i.e. the FID and/or spectrum, parameter files
and various other information. A dataset is defined by the following directory tree:

<dir>/data/<user>/nmr/<name>/<expno>/pdata/<procno>
where

<dir> = top level datadirectory

<user> = user; acharacter string

<name> = data name; a character string

<expno> = data experiment number: an integer number

<procno> = data processing number: an integer number

for example:
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/ bi o/ dat a/ guest / exanild _1H 1/ pdata/l

The EXPNO and PROCNO directories contain several files, each of which holdsa
dataset component like FID, Spectrum, Parameters, Title etc. The Plot Editor
shows these components in the respective objects, i.e. the FID-object, the Spec-
trum object, the Parameters object etc.

4.2 Dataset handling

When you start the Plot Editor with the pl ot the current TOPSPIN dataset will be
shown with the current layout. From the Plot Editor interface, you can open a dif-
ferent dataset, with the Dat a command button or from the TOPSPIN menu.

Exercise 13
1. Start TopsPiN and open a 1D dataset of a proton spectrum.

2. Enter| ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected).

3. Enter pl ot . The Plot Editor interface will appear.

4. Movethe cursor around in the layout area through the different objects.
Whenever the cursor is located in an NMR object, the status line will show
the dataset associated with that object, e.qg.

Position: 11.50,13.70 {iZ: /bio/datafguest/nmr fexamid_1H[1/pdata/1)

Note that in this example, all NMR objects like Spectrum, Title, Parameters
are associ ated with the same dataset, the dataset Plot Editor was started with.

5. Click File— Print[Ct r | +p], select the printer in the appearing dialog and
click Print.

6. Gotothe TopspIN interface and open adifferent 1D proton spectrum.
7. Gotothe Plot Editor interface and click TOPSPIN — Get Current Dataset

See how all NMR objects nhow show the new dataset.

8. Click File— Print[Ct r | +p], select the printer in the appearing dialog and
click Print.

Steps 6, 7 and 8 can be repeated to print a series of datasets with the same layout.
Usually, Reset Actions (see also Chapter 8) arerequired, in which casestep 7 and 8
can be replaced by:
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1 Click TOPSPIN — Get Current Dataset + Reset + Print

Instead of getting a new dataset from the TOPSPIN menu, where you have to
switch between the TopPsPIN and Plot Editor interface, you can also use the Dat a
command button, which opens the Data Set Sel ector/Portfolio (see paragraph 4.3).

In the exercise above, we used the layout 1D_H.xwp, which holds one dataset
only. Thisisthe case for most Bruker 1D layouts. More complex layouts can hold
multiple Spectrum objects associated with different datasets (see paragraph 4.3)

4.3 Portfolios

4.3.1 Using portfolios

The Plot Editor organizes datasets in portfolios. A portfolio consists of a:

e Directory list:
A list of top level data directories D, Thislist can be set up in the Portfolio
Editor.

o Dataset list:
A list of selected datasets in the top level directories. Thislist can be set up
in the Portfolio Editor and will be displayed in the Data Set Selector.

To open the Data Set Selector:

1= click the Data button of the command bar (see Figure 4.1)

Aﬂributes‘ Zoarm in |
o.,o0 o
oo

Figure4.l

To open the Portfolio Editor:

1) Thetop level directory isthe <dir> part of a datapath.
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1= click the Edit button in the Data Set Selector dialog (see Figure 4.2).

Data Set Selector gj
1: C:./Bin/datas guest/nmrfexam1d 13041 ‘pdats ak.
Apply
LCancel

Figure4.2

Let’s see how thisworks by creating a plot layout with multiple 1D datasets.

Exercise 14

1. Start TopspPIN and open the datasets examl1d_13C/1/1, examld 13C/2/1 and
examld 13C/3/1 in three different data windows D). Click in the datawin-
dow of examld 13C/1/1to make it the current dataset.

2. Enter| ayout onthe command line. In the appearing dialog, select the
standard layout 1D+1D+1D.xwp.

3. Enter pl ot . The Plot Editor interface will appear.
The layout will show three 1D Spectrum objects above each other. Only the
upper one contains a spectrum.

& The Data Set Selector positionsare stored in the layout, not the datapaths

4. Move the cursor through the three 1D Spectrum objects and look at the sta-
tusline. For the upper object the status line shows the current dataset, for the
other two objects it shows nothing.

The reason for the lower objects to be empty is their association with the en-
tries 2 and 3 in the Data Set Selector, which have not been defined yet.

1) Make sure these datasets are processed.
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5. Click the Data button of the command bar to open the Data Set Selector.

Thisshows only one entry, consisting of anumber and adatapath (see Figure
4.2).

& Thefirst entry in the Data Set Selector is, by default, the current dataset.

6. Click Edit inthe Data Set Selector dialog to open the Portfolio Editor (see
Figure 4.3).

7. Select dataset examld_13C/2/1 by clicking the respective entries in the sec-
tions Directory, User, Name, Expno and Procno. Then click the Append but-
ton. Repeat this for dataset examld_13C/3/1. The Portfolio section of the
dialog will now show three datasets (see Figure 4.3).

8. Click Apply. Thiswill close the Portfolio Editor, update the Data Set Selec-
tor (see Figure 4.4) and fill the second and third Spectrum object with data.
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Portfolio Editor

File Edit
Directony: Hame: Erpric: PBrocno:
1
C:Abiol 2
C:htz2.0 exam2d_CH
examad_HC 4
exam2d_HH 5
exam3d 5
Uzer:

Partfalio:

C:/Bin/data/guestnmrfexamld_13C41 /pdatadl
C./bio/datalguest/nmrfesam1d_13C/2/pdatas]

L /bio/data/quest/nnr/examld 13043/

Apply | Llose I Append |

Inzert ‘ Bemove 1

Figure 4.3

9. If you do not see a spectrum in object 2 and 3, please do the following:

a) Right-click in the object and choose 1D/2D-Edit from the popup menu.
b) Inthe 1D/2D-Edit dialog, click the following icon:

- to reset the vertical and horizontal position of the spectrum.

| EE BN

o
b

10.Move the cursor through the objects and see how the respective datapaths
appear in the statusline.

4@ Each NMR object isassociated with an entry (number) in the Data Set Selector
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Now let’s play around with the object - dataset association.
11.Mark the upper Spectrum object (associated with the first entry).
12.Click the entry number 2 in the Data Set Selector.
13.Click the Set button.

14.Move the cursor into the upper Spectrum object and check the datapath in
the status line. The object is now associated with the dataset at entry 2.

15.Repeat step 11 to 14 for the upper Parameters object.
Note that clicking Set, also selects the dataset for new NMR objects.

| ObJ ect # H Data Set Selector | X .
I I

‘ 1: C:/Bin/data/quest/nrr/exarld_13C/1/pdatal1 0K
oo oo oo Ll T Lot et [ ]
F— — — — — _ — — — 3 C:/bin/datadguestinmnexaml d_13C/3/pdata/1 Apply
| Obiect#z | || =
T I
b — T T Edt
v G
| Object #3 ’ e
| ‘ i H{ w } ! | § |
L s

Figure4.4
Important:

« the positions (numbers), not the datapaths, are stored in the layout

Note that the dataset that is associated with an object can also be changed from the
Edit dialog as demonstrated in the next exercise.

Exercise 15
1. Right-click a Spectrum object and choose Edit from the popup menu.
2. Click the Data Set tab in the Edit dialog (see Figure 4.5).
3. Click the Select... button.
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. Data Set ] Ea

Data C:/Bin/data/guest/nmrdexamld 13C41 /pdatad

Figure 4.5 Edit dialog of a 1D Spectrum object

The Data Set Selector will appear.

4.
5.
6.

7.

Select the desired dataset in the Data Set Selector and click OK.
Close the Edit dialog by clicking OK.

Move the cursor into the respective object and seein the status linethat it is
now associated with the selected dataset.

Repeat step 1 to 5 for the Parameters object.

A complex layout with multiple datasets, can be created once and used repeatedly,
with different portfolios.

4@ Onelayout can be used with multiple portfolios, inter actively or automatically

4.3.2 Portfolio Editor functions

The Portfolio Editor allows you to load, modify and save portfolios. Note that a
portfolio consist of adirectory list (shown in the Directory field) and a dataset list
(shown in the Portfolio section, see Figure 4.3).

The Portfolio Editor offers:

Themenus Fileand Edit with functionsto load, modify and save adirectory
list.

Thefields Directory, User, Name, Expno and Procno showing the available
datasets and allowing you to select a dataset to be appended to the dataset
list.

The Portfolio field, showing the current dataset list.

The buttons Append, I nsert and Remove to modify the dataset list.
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e The buttons Apply and Close to close the Portfolio Editor, with or without
save, respectively.

The buttons at the bottom of the Portfolio Editor have the following functions:

Append
Add the selected (highlighted) dataset to the end of the list. Equivalent to
double-clicking the dataset.

Insert
Insert the selected (highlighted) dataset before the selected entry in the Port-
folio field.

Remove
Delete the selected (highlighted) dataset from the Portfolio field.

Apply
Apply al changes, update the Data Set Selector and close the Portfolio Edi-
tor.

Close
Close the Portfolio Editor, without updating the Data Set Selector.

The File menu of the dialog provides the following commands:

Load...
Open adialog to select and load a portfolio.

Append...
Open adiaog to select a portfolio and append it to the current portfolio.

Save as...
Save the current dataset list to the specified portfolio.

Save as default..

Save the current portfolio asthe default portfolio. It isstored in the directory
<userhome>/.topspin-<hostname>/default.por. If this action has never been
performed, the default portfolio contains the ToPsSPIN browser directory list
and an empty dataset list.

Reset
Reset to the default portfolio, discarding any changes.

Close
Close the Portfolio Editor.
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The Edit menu offers the following options:

Sort Ascending
Sort the dataset list in ascending order

Sort Descending
Sort the dataset list in descending order

Clear
Remove all selections from the Portfolio field.

Edit Directory List

Specify the top level data directories that contain TopsPIN data. Top level di-
rectories are valid data directoriesif they contain a subdirectory dat a with
TopspPIN data. Thedirectory list dialog displaysall currently valid directories
in alist box (Figure 4.6). Data directories can be added to thislist by speci-

Directory List g|
Current directaries
C:/bio
C:hbiol
Directnry:|

Figure 4.6 Editing the datadirectory list

fying their names in the Directory text field and clicking the Add button. To
remove one or more directories from the directory list, select them and click
the Remove button. The current directory list will be accepted by the Portfo-
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lio Editor after clicking Apply.

4.3.3 Using the Portfolio Editor to set up a stacked plot

A stacked plot isaplot of a series of 1D spectra, which are plotted with increasing
offset. The spectra are taken from the Data Set Selector, in ascending order. By
default, the Data Set Selector only contains the current dataset and, if these are
defined, the second and third dataset.So normally, you have to fill the Data Set
Selector with the datasets to be included in the stacked plot, before you create a
stacked plot object.

Exercise 16

1
2.

Open the first spectrum to be included in the stacked plot.

Enter pl ot . The Plot Editor interface will appear, showing the current data-
Set.

Click the Data button of the command bar to open the Data Set selector. It
will show an entry with the current dataset.

Click Edit in the Data Set Selector dialog to open the Portfolio Editor.
In the Portfolio Editor:

a) Select the additional datasets to be included in the stacked plot. For each
dataset, click the Append button to add it to the Portfolio list.

b) If you want to display the spectrain descending order:
i==click Edit — Sort Descending
c) Click Apply to load the Portfolio list to the Data Set Selector.

6. Click OK to close the Data Set Selector.

Right-click in the Sacked Plot object and choose Edit from the popup
menu.

In the appearing diaog:

a) Click the Stacked tab.

b) Enter the number of spectra

c) Enter the horizontal and vertical offset or accept the default values.
d) If you want the white washed effect (only foreground curves visible):

>enablethe checkbox Set curveattributesto“ White Washed” on OK
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4.3.4

e) Click OK.

Note that the White Washed checkbox defines a one time action on OK. It is
aways disabled on opening the Edit dialog. To undo the white washed effect, you
must do the following.

1. Right-click in the Sacked Plot object.
2. Click the Attributes button in the Cur ve section.
3. Inthe appearing dialog, click the Default button, then click OK.

When creating stacked plots, it is useful to choose dataset names that allow easy
sorting, ascending or descending. For example, temperature dependent measure-
ments, where the stacked plot shows the effect of rising or falling temperatures,
dataset names might contain the acquisition temperature.

Note that the standard AU program st ack1d automatically creates a stacked plot
of aseriesof 1D spectrain consecutive EXPNO’s or PROCNO's. For more details
on stacked plot objects, see paragraph 5.8.7.

Portfolio handling during Plot Editor startup

When you start the Plot Editor, it normally showsthe current dataset. However, the
dataset handling during startup can be highly manipulated by using portfolios. The
following happens during startup.

1. Thedefault portfolio is loaded.

2. Thefileportfoli o. por inthe processing directory (PROCNO) of the
current dataset isloaded, if it exists. It overrides the default portfolio.

3. Thefirst entry of the portfolio dataset list is replaced by the current TOPSPIN
dataset.

4. The second and third entry of the dataset list are replaced with the second
and third TopsPIN dataset, if they are defined (e.g. withedc?2 or pr oj d).

Theresult of these stepsis shown in the Data Set Sel ector, which can be opened by
clicking the Data button of the command bar. Most standard layouts, e.g.

1D _H.xwp only usethe first dataset in the Dataset Selector. Some layouts, e.g.
1D+1D+1D.xwp use the first three datasets.

The use of Portfolios during Plot Editor startup can be manipulated with command
line arguments:;

pl ot -i
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Ignore a possible portfolio in the dataset PROCNO (see step 2 in paragraph
4.3.4)

plot -p <portfolio>
Starts the Plot Editor with the specified portfolio, e.g.:
plot -p C\pf\nypf.port

4.3.5 Portfolio handling in automated plotting

The command aut opl ot prints data according to the current layout. It uses port-
folios in the same way the command pl ot does. This meansit |oads the default
portfolios, overrides it with the portfolio in the dataset PROCNO (if it exists) and
replaces the first entry with current dataset. As such, portfolios can be created/
modified and saved from the interactive Plot Editor (command pl ot ) and used for
command line plotting (command aut opl ot ) and automation (macro AUTO-
PLOT). Furthermore, aut opl ot supports the following arguments to manipulate
portfolio handling:

-p portfolio. por L oads the portfolio port f ol i 0. por

-a portfolio. por Appends portfolio.por tocurrent portfolio
-d <dat apat h> Adds dataset <datapath> to current portfolio

-r <dat apat h> Removes dataset <datapath> from portfolio
-sa Sorts portfolio in ascending order

-sd Sorts portfolio in descending order

aut opl ot can take multiple portfolio arguments, which are evaluated | eft to
right.






Chapter 5
Handling Objects

An object isagraphical element of alayout. Objects can be NMR objects like
Spectrum, FID, Parameters, Title etc. or Sandard objects like lines, squares

curves etc. Each object has its own position, size, attributes and properties. Each
NMR object hasits own Reset Actions.

5.1 Marking/unmarking objects

In order to manipulate an object, it often must be marked (selected) first. To mark
an object, click one of the following icons:

- Mark an object asawhole.

..................

j\fﬂ Mark an object by individual points.

Then click the object to be marked.
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Marked objects are indicated by green markers around them. For most objects
there is no difference between the two marking modes. For some, however, thereis
adifference, like for polylines and polygons curves (see Figure 5.1).

RAVah!

O O
O
O O
Figure 5.1 Polyline object, marked by its points (above) and as awhole (below).

When marking such an object by its individual points, the position of each base
point can be individually changed using the mouse. This results in the object
changing itsform, i.e. the form of its bounding box. When an object ismarked asa
whole, only the objects dimensions can be changed, but not itsindividual point
positions.

Note that if you right-click an object and choose any of the functions in the popup
menu, the object isimplicitly marked.

To mark multiple objects:

1= Click each object with the left mouse button while pressing the Shi ft mod-
ifier key on the keyboard.

or

1= Put the mouse cursor outside of all objects to be marked, |eft-click-hold and
move the mouse to draw a box around all objects. On releasing the mouse
button, all objects inside the box will be marked.

To mark all objects:

1 Click Edit > Mark All [Ctr| +a ]
To unmark an object:

1= Left-click in the marked object

or

1z Mark a different object
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Tounmark all objects:
1= Click Edit —» Unmark All [Ct r | +m]

5.2 Deleting objects

To delete one or more obj ects:

1z Mark the object(s) and click the Delete button of the command bar.
To quickly delete one object:

1 Right-click the object and choose Delete from the popup menu.
To delete all objects:

1> Press Ct r | +a and click the Delete button

Notethat instead of clicking the Delete button, you can also click the menu Edit —
Delete or pressthe Del et e key on the keyboard.

If you accidentally deleted an object, you can easily bring it back by undoing the
last operation(s) (pressCt r | +z).

5.3 Copying/Duplicating obj ects

Plot Editor supports duplicating objectsin the current layout and copying objects
to other layouts and other applications.

5.3.1 Duplicating objects

If you duplicate an object, it is copied and the copy is placed in the same layout, at
a slight offset from the original object.

To duplicate one or more objects:

1z Mark the object(s) and click Edit — Duplicate
To quickly duplicate one object:

1 Right-click the object and choose Duplicate from the popup menu.
To duplicate all objects:

1 Press Ct r | +a and click Edit — Duplicate
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5.3.2 Copying objects

If you copy an object, it is placed on the clipboard and can be pasted to any Plot
Editor layout or any other application.

To copy one or more objects:

1z Mark the object(s) and click Edit — Copy [Ct r | +C ]
To quickly copy one object:

1 Right-click the object and choose Copy from the popup menu.
To copy all objects:

1 PressCt r | +a and click Edit — Copy [Ct r | +C ]

Copied objects can be pasted to the same or to a different Plot Editor layout by
clicking Edit — Paste [Ct r | +Vv ]. Pasted objects appear at the same position asthe
original objects.

5.4 Manipulating objects

5.4.1 Moving an object

In order to move an object:
1= Click-hold the object, move the mouse and release it at the desired position.

You don't need to mark an object in order to moveit.

5.4.2 Resizing an object

Objects can be resized graphically or numerically.
To resize an object graphically:

1z Mark the object as a whole (see above), click-hold one of the green markers,
move the mouse and release it when the desired size has been reached.

To resize an object numerically:
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1. Right-click in the object and choose Edit from the popup menu.

Graph ] 10 Spectlum] [1ata § @

Ensitinn " m W 1. 200000

Dimensian | 13740000 4 | 14.650000

Figureb5.2

2. Inthe appearing dialog (see Figure 5.2) :
a) SelecttheBasictab D
b) Specify the Dimension for x and y in the respective fields.
c) Click OK.

Note that the object will be resized with respect to the lower left corner of the
object (specified asthe x and y Position in the Edit dialog).

5.4.3 Grouping/ungrouping objects

Sometimes operations like moving or scaling have to be applied to a number of
objects, for exampleif these objects arerelated. In thiscaseit is useful to group the
objects and then perform the action to the group.

To group objects:
1z Mark the desired objects and click the Group button.

Instead of clicking the Group button, you can also click the menu Edit — Group
orpressCtrl +g.

To quickly group all objects:
1 PressCtr | +a and pressCt r | +g.
To ungroup objects:

1z Mark the grouped object and click the Ungroup button.

1) Under Linux, Tabs do not exist, dl diaog parts are shown simultaneously (see chapter 12)
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Instead of clicking the Ungroup button, you can also click the menu Edit — Un-
group or pressCt r | +Shi f t +g.

Note that the Group button is only enabled if two or more objects are marked and
the Ungroup button is only enabled if a grouped object exists and is marked.
5.4.4 Rotating objects
Marked objects can be rotated counterclockwise in steps of 90°.
To rotate one or more objects:
1z Mark the object(s) and click the Rotate button.
To quickly rotate one object:
1 Right-click the object and choose Rotate from the popup menu.
To rotate all objects:
1 Press Ct r | +a and click the Rotate button.
Instead of clicking the Rotate button, you can also click the menu Edit — Rotate.
Note that clicking Rotate several times rotates marked objects by 90°, 180°, 270°,
etc.
Rotation can not be performed on imported Windows M etafile Graphics. You can
rotate the Meta object but the imported graphics will keep the original orientation.
The same counts for EPSI objects under Linux.
5.4.5 Raising and lowering objects

Raising or lowering an object means bringing it to foreground or background,
respectively. Thisis sometimes necessary when objects are overlapping.

Toraise oneor more objects:

1z Mark the object(s) and click Edit - Raise[Ct r | +r].
To quickly raise one obj ect:

1 Right-click the object and choose Raise from the popup menu.
To lower one or mor e objects:

1z Mark the object(s) and click Edit — Lower [Ctr | + ].
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5.4.6

54.7

To quickly lower one object:
1> Right-click the object and choose Lower from the popup menu.

Note that objects are always raised or lowered with respect to other objects. Rais-
ing or lowering al objects has no effect.

Using a spectrum or FID asclipping window

If you move a Spectrum object, the spectrum curve moves along with the bounding
box, keeping the displayed spectral area the same. However, you can also move a
Spectrum object, keeping the X and/or Y position of the curve the same, thereby
changing the displayed part of the spectrum. Assuch, you use the Spectrum object
as aclipping window. To do this;

1= Click-hold the object and move the mouse while holding down one of the fol-
lowing keys:

e Shi ft tokeep the X-position of the spectrum curve.
e Ctrl tokeepthe Y-position of the spectrum curve.
e Alt tokeep both the X and Y-position of the spectrum curve.

The same procedure can be used for an FID object.

Undo last operation(s)

Plot Editor operations can easily be undone and you can undo as many operations
as you want.

To undo an operation
1= Click the button Undo at the upper right of the Plot Editor interface
or
= pressCrl +z

Repeat this action if you want to undo multiple operations. Note that Undo only
works for actions that actually change the layout. It does not work for actions like
changing the input mode or changing attributes for objects to be created.
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5.5 Creating new objects

New objects can be created simply by clicking the respective icon at the left of the
Plot Editor interface and then clicking at the desired position in the layout area.

Createan NMR object

To create an NMR object, take the following steps:

1. Enabletheradio button NMR at the left of the Plot Editor interface (if itis
not already enabled).

2. Click the desired object icon, e.g. Title or 1D Spectrum. Note that the M ode
field now indicates that object.

3. Placethe cursor in the layout area at the desired position.

4. For some objects, e.g. 1D Spectrum or FID you have to left-click-hold and
move the mouse to draw the object. For other objects, like Title and Param-
eters, you only haveto left-click at the desired position.

Create a Standard object

To create a Sandard object, take the following steps:

1. Enablethe radio button Standard at the left of the Plot Editor interface (if it
is not already enabled).

2. Click the desired object icon, e.g. Line or Square.
3. Placethe cursor in the layout area at the desired position.

4. For some objects, e.g. Line, Square and Circle, you have to left-click-hold
and move the mouse to draw the object. For other objects, like Bezier curves
etc., you must left-click multiple times while moving the mouse to draw the
object and, finally, middle-click to finish.

More information on creating new objects, as well as importing graphics can be
found in paragraph 6.5.
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5.6 Setting Object Attributes

Plot Editor allows you to set various graphical attributes such as colors, fonts, line
styles etc. You can change the attributes of existing objects in the layout or set
attributes for new objects to be created.

To change attributes of an existing object:

1= Right-click the object and choose Attributes from the popup menu.
To change attributes of all existing objects:

1> Press Ct r | +a and click the Attributes button of the command bar.

To set attributes for new objectsonly:

s Press Ct r | +mY and click the Attributes button of the command bar.
Clicking the Attributes popup menu or button will open the Attributes dialog
where you can set the colors, fonts, line styles etc. (see Figure 5.3). Make any

Attributes §|

File

Color zelection
&+ Ling © Fill Line Salid -
; I—_|' Apply
|i !J ! Line 1

jjﬁﬂ FilSwle [Urfled  +] ﬂ
Font selection

[

RGE Calar: ! |EDurierN3w ﬂ
Defau

Figure5.3

desired changes and click OK to apply them and close the dialog.
Further details on setting attributes are described in the paragraphs bel ow.

1) To deselect any existing objects.
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5.6.1 Setting Color Attributes

The graphical attributes Line Color and Fill Color can be set from the Attributes
dialog, in two different ways.

1= Click one of the 16 displayed standard colors.
or

1. Click the Change... button.

2. Inthe appearing dialog, select one of 48 basic colors or add your own cus-
tom color.

3. Click OK to save and close the dialog.
4. Click the RGB Color field to actually select the new color.

Theway you can add custom col ors (see step 2 above) depends on the operating
system and may involve moving sliders or entering RGH or HSL values.

If the number of available colorsis exhausted 1), the color shades shown in the

Color field may not reflect the true values indicated by the contents of the text

fields or by the slider positions. However, this does not affect the colors as they
appear on a printout.

The settings for Line and Fill color can be changed independently. You can switch
between them by selecting the corresponding radio button (see Figure 5.3).

5.6.2 Setting Font Attributes

The Attributes dialog allows you to set the font for any object that contains charac-
ters like Spectrum (the axis units), Title or Parameters.

To change the Font Type:
1= Click in the Font Selection field and select afont type.
To change the Font Size:

1= Click theright part of the Size field and select afont unit (Pt, cm or inch), then
click the left part of the Size field and enter or select the font size.

1) The maximum number of different colors depends on the display hardware.
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5.6.3 Applying/Setting Attributes

When you have set all the desired attributes, you can use the following buttons to
apply the changes:

* Apply to apply attributes (disabled if no object is marked or exists)
e OK to apply attributes and close the dialog
o Default to reset the attributes to default

Notethat both Apply and OK apply the changes to marked objects and set them for
new objects.

5.6.4 Which attributes apply to which objects
Table 5.1 shows allist of attributes and the objects they apply to.

Attribute NMR Objects Sandard Objects
LineColor All (including text objects) All (including text objects)
Fill color 1D Spectrum, 2D Spectrum,  Circle, Square, Polygon, Closed

Fid, Stacked, T1/T2 Bezier
Line 1D Spectrum, 2D Spectrum,  Line, Square, Circle, Polyline,
Syle/Width  Fid, Stacked, T1/T2 Polygon, Open/Closed Bezier

Fill Syle Closed Sandard objectsand  Circle, Square, Polygon, Closed
NMR graphical objectslike.  Bezier

Font Title, Parameters, 1D Spec- Text
Syle/Size trum, 2D Spectrum, Fid,
Stacked, T1/T2

Table5.1

5.6.5 Saving/opening a set of attributes
A set of attributes can be saved from the attributes dialog as follows:
1> Click File - Save As
to save the current attributes under a new name.
1> Click File —» Save As Default

to save the current attributes as default. 2
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1= Click File— Open

to open anew set of attributes.

5.7 Display functions of NMR spectrum objects (1D/2D-Edit)

The Plot Editor offers an easy to use dialog, the 1D/2D-Editor, for graphical NMR
objectslike 1D and 2D spectraand FID’s. It allowsyou to expand, scale and shift a
spectrum interactively, as well as enable/disable axes, grids and peak- and integral

labels.

5.7.1 1D spectra
To open the 1D/2D-Editor diaog:
1 Right-click an 1D Spectrum object and choose 1D/2D-Edit

The buttons at the upper part of the dialog (see Figure 5.4) allow you to shift and
scal e the spectrum.

Expand *2 12 *8

— = T | b

Figure5.4

=*1P0s
/8

- Click-hold this button and move the mouse | eft/right to shift the spec-
trum horizontally.

1 Click-hold this button and move the mouse up/down to shift the spec-
trum vertically.

Click-hold thisbutton and move the mousein any directionto shift the
spectrum accordingly.

‘> Click-hold this button and move the mouse left/right to smoothly ex-

1) Default attributes are stored in <userhome>/.topspin-<hostname>/default.att
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pand the spectrum (1D objects only).

Click-hold this button and move the mouse up/down to smoothly
scal e the spectrum intensity up/down.

Click-hold this button and move the mouse up/down to expand/con-
tract the spectrum, horizontally and vertically.

Click this button to increase the intensity by afactor of 2.

Click this button to decrease the intensity by afactor of 2.

Click this button to increase the intensity by afactor of 8.

Click this button to decrease the intensity by afactor of 8.

Click this button to fit the left limit of the spectrum to the left edge of
the object bounding box.

Click thisbutton to fit the right limit of the spectrum to the right edge
of the object bounding box.

Click this button to fit the upper limit of the spectrum to the upper
edge of the object bounding box.

Click this button to fit the lower limit of the spectrum to the lower
edge of the object bounding box.

Click this button to reset the expansion and position to default, show-
ing the full spectrum.

The scope of the above buttons can be set, at the top of the dialog, to Spectrum,
and/or Integral (see Figure 5.5).

Scope: W Spectrum v Antearat

Figure5.5

Note that the scope Integral is only relevant if the integral labels are actually dis-
played, i.e. the Integrals checkbox is enabled. Furthermore, horizontal scaling or
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shifting is always applied to spectrum and integrals, independent of the selected
scope.
Below these push buttons, you find a number of check buttons (see Figure 5.6)

v fiziz on Bottam [ AxizonTop

I Awiz on Left [ Axiz on Right

[ #Gnd [ %-Gnd

v Peaks [ Integrals
Figure 5.6

which allow you to enable/disable;
e axes at the top/bottorm/left/right of the spectrum
e an X- and/or Y-grid
 integral and/or peak labels
In Figure 5.6 only the axis at the bottom and the peak labels are enabled.

Note that the check buttons Peaks and I ntegrals are available for 1D Spectrum
objects, but not for FID objects or 2D Spectrum objects.

In some cases, it is useful to exactly define the relationship between the frequency
scale and a spectrum‘ s width, for example if you want to compare spectra or ana-
lyze coupling patterns. For this purpose, the 1D/2D-Edit dialog offers the fields
shown in Figure 5.7.

ppm | percm; (12073
tiddle w | DOffget: 100

Get Valuesz | UseWalues |

Figure5.7

Here you can numerically set:
e theaxisunit and scaling value
 the offset position and value

The buttons Get Values and Use Values allow you to get the current values from
the object or use the specified values for the object, respectively.
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Notethat these fields and buttons are available for 1D Spectrum objects but not for
FID or 2D Spectrum objects.

5.7.2 2D spectra
To open the 1D/2D-Editor:
1 Right-click a2D Spectrum object and choose 1D/2D-Edit

The upper part of the dialog (see Figure 5.8) is basically the same as for 1D Spec-
trum objects (see above). The middle part offers buttons for scaling and shifting
the projections at the Top, Bottom, Left and Right of the 2D spectrum. The lower
part of the dialog allows you to set the 2D contour levels.

To add acontour level:

1> Enter alevel inthe Value field and click Add
To remove a contour level:

1> Select alevel and click Remove

To edit all levels:
1. Click Edit
2. In the appearing dialog (see Figure 5.9)

1= Enter the positive and negative base levels, the total number of levels and
the increment (multiplication factor) and click OK.

To set/change the color of one or more levels:
1. Select thelevel(s)
2. Click the desired color in the color table, or click the RGB color field D,
3. Click Apply.

1) To change the RGB Color, click the RGB ... button .
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X]

Edit 2D Display Object

o>ld
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Expand *2 12 *8

— — T L

¥ iz on Botharn [ &xizon Top
I Awiz on Left [v iz on Right
I #Gnd [ %-Gnd

28T ILce,
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#2112 *8 18|
Mg ||

3000000 ~ I
-4000000 [ T
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Walue: ’7 E

Add | Bemove _

| Apply |

LClose

Figureb.8

To create a color flow between 2 contour levels;

1. Select the lowest contour level to be included in the color flow, select its
color and click Apply.

2. Select the highest contour level to be included in the color flow, select its
color and click Apply.

3. Select the lowest contour level to be included in the color flow while keep-
ingthe Ct r | key pressed. Now both the lowest and highest level are
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sel ected.
4. Click the button Create Color Flow.

Notethat the Create Color Flow buttonisonly activeif 2 or more contour levels
are selected.

Poszitive Baze

Meqative Baze 1000000
Total Mumber of 8

Increment 2
ok | Apply | Cancel |
Figure5.9

5.8 Edit NMR and Sandard object properties

Besides attributes and display properties (1D/2D-Edit), there is athird way to
manipul ate spectrum objects; by editing object properties. You can do that for both
Sandard and NMR objects.

In order to edit object properties:
1= Right-click the object and choose Edit from the popup menu
or
1 Double-click the object

Alternatively, you can mark the object and click the Edit button of the command
bar or click the menu Edit — Object Properties ... Note that you can only edit one
object at atime. As such, the Edit button of the command bar is disabled, if multi-
ple objects are marked.

A dialog will appear showing several tabs which allow you to select the corre-
sponding dialog panes. Note, however, that under Linux, all panes are shown
simultaneously and tabs do not exist (see Chapter 12). Under Windows, the
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number and type of the tabs/panes, depend on the object being edited. The leftmost
tab is selected by default. Table 5.1 shows alist of all tabs/panes, the options/func-

tions they offer and the objects to which they apply.

Metafile object

Select metafile and set resize and
dimension options.

Set axis units and contour level

Slze.

Tab/Pane Functions Available for Object
Basic Set object position, dimension NMR: al
and, for some objects, attributes. Standard: all
Select a dataset from the Data Set )
Dataset Sel ector/Portfolio. NMR: al
Granh Set limits, axes, grids, bounding NMR: 1D Spectrum, FID, 2D
ap box and attributes. spectrum, Stacked Plot and T1/T2
1D Spectrum Setaxisunits, peaksintegral set- o 1 Spectrum
tings, X-axis scaling info.
Text Edit text and set resizeand align- NM R: Title, Parameters, Text
ment options. Standard: Text (ABC)
Parameter  Set electronic signature options. NM R: Parameters
NMR Text Select the NMR Text file. NMR: NMR Text

Standard: Metafile object

2D Spectrum attributes. NMR: 2D Spectrum
2D Projection Select projection dataset, Setpro- i p- op Spectrum
jection size.
T1/T2 Set tags and annotations. NMR: T1/T2 data
Set arrow style, direction and Standard: Line, Polyline and
Arrow

Open Bezier Curve

Table 5.1 Tabsin Edit dialog of various objects

5.8.1 Edit 1D-Spectrum properties
To edit the properties of a 1D Spectrum object:

1 Right-click in the object and choose Edit from the popup menu.
The 1D Spectrum Edit dialog will appear, with the Graph tab selected (see Figure
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5.10). Three further tabs 1D Spectrum, Data Set and Basic are available

’ Spectlum] Data Set] Basic ]

Plat
Hmin / Xmas | 11.008050 /| -1.008057
Yrin £ Y mas: | -7A2451 870549/ | 1044272 7a1534
™ Scale Bounding Box I Draw Box around
Auez

[ Left [~ Top
Attribut
[+ Battom I Right &

¥-awiz offzet: 0.2 -z 0z

Grids Curve

[ = awis

™ Y axis Attributes Abtributes

ak | Cancel | Apply | Help |

Figure5.10

The Graph pane

The Graph pane of the Edit dialog shows four sections:. Plot, Axes, Gridsand
Curve, offering various options/functions (see Figure 5.10).

Plot section: limits and bounding box properties.

e Xmin/Xmax: X-direction limits of the object. For a1D spectrum, these
determine the displayed spectral region.

e Ymin/Ymax: the Y-direction limits of the object. For a1D spectrum
these determine the minimum and maximum intensity.
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e Scale bounding box (unchecked by default): when checked, the bound-
ing box, which determines the logical position and dimension of the
object, includes the axes, peak labels and integral labels. It should be
checked when grouping a Spectrum object with aframe and unchecked
when grouping a Spectrum object with an annotation (text and line
object).

e Draw Box around curve (unchecked by default): when checked, a box
is drawn around the curve object.

AXes section

e Top, Bottom, L eft, Right: check buttons to show/hide the respective
axes. By default, only the bottom axis (X-axis) is shown.

e Attributes; axis attributes like line color/style and font style/size.

e X-Axis offset, Y-axis offset: slidersto set the distance (in cm) between
the axes and the spectrum.

Grids section

e X axis, Y axis: check buttonsto switch on/off the respective grids.
Switched off by default.

e Attributes: grid attributes like line color/style.

Note that the Graph pane isonly available in the Edit dialog of objects that sup-
port axes and grids, like the NMR objects 1D Spectrum, 2D Spectrum and
Sacked Plot.

The 1D Spectrum pane
The 1D spectrum pane of the Edit dialog shows four sections: Units, Peaks, I n-
tegrals and Scaling I nfo, offering various options/functions (see Figure 5.11).
Units section
« X-Axes: radio buttons to select the axis units. ppm, Hz or Points

« Peak Labels: radio buttons to select the peak label units. ppm, Hz or
Points
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Fete @ ppm Hz © Points

Peaklabelz: & ppm © Hz O Paints

Peakz
[ Show Peak Marks
[ Show Peak Labels

R

Where peak annotations are available show
* pozitian " annotation " bath
Integralz

[ Shaow [ntegrals

[ Show Integral Labels

e

-

Scaling Info

[ Show szaling inforrnation for ¥ axis
Ok | Cancel | Apply | Help |

Figure5.11

Peak s section

Show Peak Marks: check button to show/hide peak marks
Show Peak L abels: check button to show/hide peak labels

Text Format: text field to specify the peak label text format. Thisisa C-
language format identifier. Default is “%.3f”, which is a double with a 3-
digits decimal part. Here you can change the number of decimals show
for the peak labels.

Attributes: peak label attributes like line color/style and font color/style/
size
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+  Show Peak Positionsand/or Annotations ¥): radio button to show peak
positions and/or annotations

Integrals section
e Show Integrals. check button to show/hide integrals traces
e Ymin/Ymax: the Y-direction limits of the integrals
e Show Integral Labels: check button to show/hide integrals labels

e Text Format: text field to specify peak label text format. Thisisa C-lan-
guage format identifier. Default is“%.3f”, which isa double with a 3-
digits decimal part.Here you can change the number of decimals show
for the peak labels.

e Labelsabove X axis: check button to place theintegral labels above
(checked) or below (unchecked ) the axis.

e Attributes: integral label attributes like line color/style and font color/
style/size
Scaling Info section

e Show Scaling Information for X axis: check button to show/hide the
the Scale: ppm/cm and Hz/cm, below the X-axis (see Figure 5.12).

4 3 2 1 0 ppm
Scale: 0.6087 ppmlcm, 304.4 Hz/cm

Figure5.12

Thisinformation isimmediately updated whenever the X -axis scaling chang-
es, e.g. when the spectrum is expanded or compressed or when the object di-

1) Only implemented in TOPSPIN 2.1 and newer.
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mension is changed. This counts for both interactive plotting and in
automation.

The Data Set pane

The Data Set pane shows one section allowing you to select the associated da-

taset (see Figure 5.13). The pathname of the dataset is shown in the Data field.

To change the dataset, click the Select button. Thiswill open the Data Set Selec-
tor dialog where you can select anew dataset. If the desired dataset is not listed

here, click the Edit button to open the Portfolio Editor, select and append the da-
taset and click Apply to update the Data Set Selector.

Edit 3

Graph ] 1D Spectrum  Data Set ] Basic ]

Data C:/Bin/data/guest/nmrdexamld 13C41 /pdatad

Select ..

Figure5.13
The Basic pane

The Basic pane shows one section with the object position and dimension (see
Figure 5.14). Here you can set the X and Y positions (in cm) with respect to the
plot areaorigin asindicated by thefaint dashed square. Furthermore, you can set
the object dimension (incm) in X and Y.

Graph ] 10 Spectlum] [1ata § @

Ensitinn " m W 1. 200000

Dimensian | 13740000 4 | 14.650000

Figureb.14
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5.8.2 Edit Title properties
To edit the properties of a Title object:
1> Right-click in the object and choose Edit from the popup menu.

The Title Edit dialog will appear, with the Text tab selected showing the corre-
sponding pane (see Figure 5.15).

The tabs/panes Data Set and Basic are the same asfor a1D Spectrum object (see
paragraph 5.8.1).

< Text }lta Set] Bazic ]

Text
[ Allovs automatic font resize a'
Alignment
Wertical: + Top " Center  Bottom
Horizontal: + Left " Center ¢ Right

[ Do not change "hat point” if alignment changes

[v Recalculate object dimensions on QK

QK | Cancel | Apply Help

Figure5.15

The Text pane

The Text pane show three sections, Text, Alignment and a“‘General’ section:

Text section

» Allow automatic font resize
Check button to enable/disable automatic adjustment of the font size
when the object isresized.
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« Edit
Push button to open an editor where you can edit the text content of the
object (see Figure 5.15). For the Title object, this allows you to change
the plot title J.

The dialog offers the following buttons:;
Load Text
Opens abrowser where you can select or enter atext file to be |oaded.
Paste
Pastes the text currently on the Clipboard to the Edit text dialog.
Character Map

Opens a character chart, with standard and special characters (charac-

1) Note that these changes are only valid for the current Plot Editor session. They are not trans-
ferred to the ToPsPIN data window nor are they stored in the layout or dataset. The original
titleis restored if you update the data from the dataset (menu TOPSPI N).
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ters not available on the keyboard).

‘B Character Map g|§|

Fort: | { Vl Help
0 I 2 e e A O I O I P MO N B Bl
SI6|7|819] | |=|=|=|?|@ABIC|DIE|IF|G|H
| FKAL{MIN|OIP QRS T{ LW S| Y 2] [N
11411 |alblc|dle| flaglbli]|]|k{!I{mn]jo]|p
qir|s|tiufywlx|yv|Z]{]] =2 AR EIES
1B CHOEBCHEEHERNLBRE
o » [tal1aFal o | Al AAAAAECIEIEIE(E| T
BN E e E R = VNN E R E
alalalale|gle|éléleli|i|T|i|d|A]|a|a|d]|d
o|+|e|ujala{a|y(b|y|Ala|Ala[Ala|Cle|Cle] e

Characters to copy | Select

[ &dvanced view

U+0021: Exclamation Mark

Figure5.16

To insert one or more characters into the text:
a) Inthe Character Map dialog: double-click the desired character(s)
b) Inthe Edit text dialog: click Paste and then Close
¢) Inthe Edit dialog: click Apply or OK

The character(s) will be inserted in the current text at the cursor position.

Alignment section

e Alignment - Vertical / Horizontal
Radiobuttons to select vertical and horizontal text alignment.

‘General’ section

« Do not change’hotpoint’ if alignment changes (unchecked by default)
Check button to enabl e/disabl e keeping the same hot point (anchor point)
when changing the alignment.
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« Recalculate object dimensions (checked by default)
Check button to enable/disable recalculation of the object dimensions to
fit the text. Useful after changing the text content, i.e. the plot title.

The check buttonsin the ‘General’ section are one time actions, performed
on clicking OK or Apply. Their settings are not stored (like the check button
Allow automatic font resize) so the next time you open the Edit dialog, their
default settings appear.

Note that the title displayed in the Title object, is normally defined in [CON-NMR
automation or, manually, by clicking the Title tab of the TopsPIN data window D,
5.8.3 Edit Parameters Object properties
To edit the properties of a Parameters object:
1= Right-click in the object and choose Edit from the popup menu.

The Parameters Edit dialog will appear, with the Text tab selected showing the
corresponding pane. The dialog is the same as for the Title object (see paragraph

1) Stored inthefileti t | e inthe dataset PROCNO directory.
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5.8.2), except for the additional Parameter tab/pane (see Figure 5.17)

Edit 3
Te:-tta Set] Basic ]

W Anclude electromic signature infornationd

I Warnif signature i missing

I warmn if signature iz invalid

QK | Cancel | Apply | Help |

Figure5.17

This pane shows one section for setting electronic signature options.

If the check button I nclude electronic signature information is enabled, the infor-
mation entered with the Topspin command esi gn will be displayed in the Param-

eters object. e.g.:
El ectroni c Signature:
USER | D j anmes
USER NANME Janmes Evans
MVEANI NG review
COMVENT Spectrumquality is ok

If Warn if signatureismissing is enabled and no electronic signature has been cre-
ated, the entry:

El ectroni c Signature: Not signed
will be displayed in the Parameters object.

If Warn if signatureisinvalid is enabled and the electronic signature has been
modified outside of ToPsPIN, the entry:
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El ectronic Signature:lnvalid checksum

will be displayed in the Parameters object.

5.8.4 Edit FID object properties
To edit the properties of an FID object:
1 Right-click in the object and choose Edit from the popup menu.

The FID Edit dialog will appear, with the Graph tab selected showing the corre-
sponding pane. The dialog is exactly the same as for a 1D Spectrum object, except
that it has no 1D Spectrum tab/pane.

5.8.5 Edit NMR Text object properties

The NMR text object can be used to include dataset specific information. Thisis
usually an external text file stored in the dataset PROCNO directory. TOPSPIN 2.1
and newer also support to include the sample information specified under the Topr-
SPIN datawindow tab Sample.

To edit the properties of an NMR Text object:
1 Right-click in the object and choose Edit from the popup menu.

The NMR Text Edit dialog will appear, with the Text tab selected showing the
corresponding pane. The dialog is the same as for the Title object (see paragraph
5.8.2), except for the additional NMR Text pane (see Figure 5.18). In the field Text
File, you can specify the pathname of atext file to be included in the plot. Here,
you have the following options:

« Specify absolute pathname, e.g.:
C./ TEMP/ ny_nnr _i nfo.txt
« Specify afilein the user home directory, e.g.:

~/my_nnr _info.txt
« Specify afilein the dataset PROCNO, e.g.:

+/ my_nnr _i nfo. prop
« Specify afilein the dataset EXPNO, e.g. the sample information file;
+/../../sanmpl e_info. prop

Alternatively, you can click the Browse button and specify or enter thetext filein
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the appearing browser.

Edit X

Te @ 3 Set] Biasic I

Test File |

Browse

QK | Cancel | Apply | Help

Figure5.18

5.8.6 Edit 2D-Spectrum properties
To edit the properties of a2D Spectrum object:
1 Right-click in the object and choose Edit from the popup menu.
The 2D Spectrum Edit dialog will appear, with the Graph tab selected.

The tabs/panes Graph, Data Set and Basic are the same as for a 1D Spectrum
object. Furthermore, the tabs 2D Spectrum and 2D Projections are available.

The 2D Spectrum pane
The 2D spectrum pane of the Edit dial og showstwo sections: Unitsand L evels.

Units section
e X-Axes: radio buttons to select the X-axis units; ppm, Hz, Points or Sec
e Y-Axes: radio buttonsto select the Y-axis units: ppm, Hz, Points or Sec
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Units
Hbwes " Paoints ¢ Sec
ates @ ppm " Hz § Pants { Sec
Lewels

Attributes Negative Poszitive

QK | Cancel | Apply | Help

Figure5.19

L evels section
e Attributes: attributes like line color/style and fill color/style for Nega-
tive and Positive levels D).

The 2D Projections pane

The 2D Projections pane of the Edit dialog shows two sections. Data Sets and
Curves (see Figure 5.20).

Data Sets section

1) Note that you can also assign different colors to individua levels (see paragraph 5.7.2)
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e Top, Bottom, L eft, Right: checkbuttonsto enabl e/disabl e corresponding
projections.

For each orientation, the following options are available:
e Size: projection spectrum height in cm.

e Select... pushbutton to open the Data Set Selector where you can
select the dataset to be shown as projection.

Curves section
e Attributes; projection attributes like line color/style and fill color/style.

Graph] 2D Spectfum 20 Frojections | Ddta Set] Basic I

Data Sets
W Top Size IW Select ...
™ Baottom li
WV it Size 200 Select ...
™ Right li

Curves

Attributes

QK | Cancel | Apply | Help

Figure 5.20
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5.8.7 Edit Stacked Plot Object properties

A stacked plot isaplot of aseries of 1D spectra, which are plotted at a certain off-
set. The spectra are taken from the Data Set Selector, in ascending order.

To edit the properties of a Sacked Plot object:
1 Right-click in the object and choose Edit from the popup menu

The Sacked Plot Edit dialog will appear, with the Graph tab selected showing the
corresponding pane. The tabs/panes Graph, 1D Spectrum, Data Set and Basic are
the same as for a 1D Spectrum object. Furthermore, the tab Sacked is available.

Mumber of Stacked Spectra; q

Spectra Offzet: 05x02

I Setcurve attibutes to "wWhite \Wash' on OK.

QK | Cancel | Apply Help

Figure5.21

The Sacked tab
Clicking the Stacked tab opens the dialog shown in Figure 5.21. Here you can
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set the following options/functions:

Number of Stacked Spectra
The number of 1D spectrato be shown in the Sacked plot object. Note that at
least this number of spectra must be available in the Data Set Selector.

Spectra Offset
Horizontal and vertical distance between the spectrain the Sacked plot object.

Set curve attributes to “ White Wash” on OK
Checkbox to enable/disable the White Wash effect. Note that in the Curve At-
tributes (Graph pane), Fill Style must be set to Solid to see the effect.

Note that the checkbox Set curve attributes to “ White Wash” on OK defines aone
time action on OK. It isalways disabled on opening the Edit dialog.

5.1 5.0 4.9 4.8 4.7 4.6 4.5 ppm
Figure 5.22 A white washed stacked plot

Figure 5.22 shows an example of a white washed stacked plot.

The spectraincluded in a stacked plot may differ in sweep width and/or chemical
shift offset. The X-limits of the stacked plot are set such that the full sweep width
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of each spectrum is displayed. For example, if a stacked plot includes the follow-
ing two spectra:

Spectrum 1: 100 - 50 ppm
Spectrum 2: 80 - 0 ppm

the X-axis of the stacked plot will run from 0 to 100 ppm. The reference peak for
intensity scaling will be the highest peak of all spectradisplayed in the stacked plot
(see also paragraph 8.4).

5.8.8 Edit T1/T2 Object properties
To edit the properties of an T1/T2 object:

1 Right-click in the object and choose Edit from the popup menu.

The T1/T2 Edit dialog will appear (see Figure 5.23). It shows the tabs/panes
Graph, Data Set and Basic, which arethe ssme asfor a1D Spectrum object. Addi-
tionally, it shows the tab T1/T2, which allows you to set tags and annotations.
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" Edit Markers

Peak Mo, 1 at 0.987 pprn, invrec, 1[0] = 1.014e+000, & = 9.1238-

I Show Tags on the left W Show Annatation
v Show Tags on the right

Attributes: Ammotation Tags

ok | Cancel | foply | Help

Figure5.23

5.8.9 Edit Line and Polyline properties
To edit the properties of a Standard Line or Polyline object:
1= Right-click in the object and choose Edit from the popup menu.

The Line Edit dialog will appear. It showsthe Basic tab, whichisthe sameasin all
other objects, allowing you to set the object’s position, dimension and attributes.
Additionally, it shows the Arrow tab, which allows you to select the arrow type
and set the arrow tip width (see Figure 5.24)
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Ao ]Basic ]

Type: - (% f—

(7| — (| f—

Tip Width: 100.0 mm

ok | Cancel | foply | Help

Figureb5.24

5.9 Reset Actionsof NMR Spectrum objects

NMR Spectrum objects define the sol-called Reset Actions, aset of rules, which
control the plot region, intensity scaling and baseline position.

Reset Actions can be set as follows:

1= Right-click in a spectrum object and choose Automation from the popup
menu.

Reset Actions can be executed as follows:

1= Right-click in a spectrum object and choose Reset Object from the popup
menu.

Reset actions are discussed in detail in Chapter 8

5.10 Axistick settings of NMR Spectrum objects

NMR Spectrum objects contain a set of Axis Tick Settings. These can be set as fol-
lows:

1. Right-click in aspectrum object and choose Axis Tick Settings... from the



popup menu.
2. Inthe appearing dialog:

Axis Tick Settings

[ Calculate axis ticks automatically
j % fodis ¥ s
Distance of labels: | 1 | 2e+006 ok |
# of minor kicks: | 9 | 1 Cancel
# of decimals: | 1] | 1
Figure 5.25

a) Click one of the radio buttons Calculate axis ticks automatically or
Fixed settings.

b) If you chose Fixed settings, enter the distance for the axislabels, the # of
minor ticks and the # of decimals, for both X- and Y-axis.

¢) Click OK to save the changes and close the dialog.



Chapter 6
Handling Layouts

The Plot Editor is based on the concept of layouts. A layout is atemplate, which
defines anumber graphical objects, which can be Sandard graphics or NMR

objects. One layout can be used for different datasets and, vice versa, one dataset
can be plotted with different layouts. TopspPIN is delivered with alarge set of lay-
outs for plotting various standard 1D and 2D experiments. Bruker layouts can be

modified to your needs and new layouts can be created, both for interactive usage
and automation.

6.1 Selecting a layout

The plot layout, used by the commands pl ot and aut opl ot , isdefined by the
processing parameter LAY OUT. To check or set the current layout, enter | ay out
on the command line. Thiswill open adialog, showing the current value of the
LAY OUT parameter, the name of the currently used layout file (see Figure 6.1).

B9 Lavout
Layout file for 'autoplat’

LAYOUT = 1D _Hoawp |

Figure6.1
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Note that the layout filename is prepended with the characters “+/”. Thisindicates
that the file is located in the layout search path (see paragraph 6.2).

The parameter LAY OUT may specify multiple layouts, separated by semicolons
(see Figure 6.2). The command aut opl ot creates as many plots as there are lay-

EM Lavout
Layout file far ‘autoplot’
LAYOUT = +H1D_Howp;+1 D_H+intxowp W |
’ 0]34 H Cancel ]
Figure6.2

outs specified in LAY OUT. Thisfeature is especially used in automation, for
exampleto plot data on two different printers. The command pl ot only interprets
the first layout specified by the parameter LAY OUT.

Note that the LAY OUT parameter can also be set by clicking the ProcPars tab of
the data window, selecting the Automation section.

6.2 Layout Storage Directories

Standard plot layouts, delivered with TopspPIN, are stored in the directory:
<t shonme>/ pl ot /| ayout s

The layout search path consists, by default, of this directory only. You can extend
the search path (see paragraph 6.2.1). Furthermore, you can specify the layout
directory when setting the LAY OUT parameter (see paragraph 6.2.2).

6.2.1 Extendingthe layout search path

TopspPIN 2.0 and newer allow you to extend the layout search path. Thisis, for
example, interesting if you want to change Bruker layouts, store them under the
same name and use them with standard Bruker experiments.

To extend the layout search path:
1. Click Options — Preferences.
2. Inthe appearing User Preferences dialog:
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a) Click Directory Path Names in the left part of the dialog.

b) Click the Change button for theitem Global search path for plot layouts.
c) Enter the Administrator password as requested.

d) Enter the search path in the appearing dialog (see Figure 6.3).

[ Directories with plot layouts

Plot layouts beginning with "+ will first be searched for in the follovwing
directaries. If they are not found, they will be taken from =topspinhomes=hlotlayouts,

Mote: Setting iz effective for all users.

| E:tplet_tayouts |

Figure 6.3
e) Click OK to closethedialog
f) Click OK to close the User Preferences dialog

Now, the commands pl ot and aut opl ot , aswell as |[CON-NMR automation will
use the search path for locating the layout specified by the LAY OUT parameter.

6.2.2 Alternative layout directories

Although layouts are normally stored in the directories of the global search path,
they can be stored in and read from any directory. Typical examples are the dataset
PROCNO or the user home directory.

To specify the layout directory, you can use the abbreviations "+", "~" or "#" :
e + :thestandard layout directory e.g.:

+/ 1D _H+H f. xwp

standsfor <t shome>/ pl ot /| ayout s/ 1D _H+l f . xwp g
e ~ :theuser homedirectory, e.g.:

~/ my_l ayouts/| ayout 1. xwp

stands for <userhome>/mylayouts/| ayout 1. Xxwp 2)

1) or the extended layout search path as set in the User Preferences.
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#  current processed data directory (see Figure 6.4), e.qg.:

#/ | ayout . xwp
stands for:

<dir>/data/<user>/nmr/<name>/<expno>/pdata/<procno>/layout.xwp

M LayouT

Layout file for 'autoplat’

La¥0UT = #hayout xmp ~|

Figure 6.4

Furthermore, you can specify the full layout pathname, e.g.

C.\TEMP\ ny_| ayout . xwp

The commands pl ot and aut opl ot can be forced to use a different layout then
specified by the parameter LAY OUT, by using command line arguments. Here you
can use the same abbreviations as described above, e.g.:

pl ot C\TEWMP\ ny_| ayout. xwp

Open the Plot Editor using layout C: \ TEMP\ ny | ayout . xwp

pl ot

~/ ny |l ayouts/| ayout 1. xwp

Open the Plot Editor using layout <userhome>/my_layouts/| ayout 1. xwp

autopl ot ~/ny_l ayouts/|ayout 1. xwp

Plot the current dataset using layout <user_home>/my_layouts/l ayout 1. xwp

Note that if the specified layout does not exist, pl ot will prompt you to create a
new layout by that name or abort. The command aut opl ot , however, will plot
the data anyway, using the layout specified by the parameter LAY OUT. The reason
isthat aut opl ot isused in automation.

2) where <userhome> stands for the user home directory (default C:\Documents and Set-

tings\<username> under Windows X P and /home/<username> under Linux.
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6.3 Using predefined layouts

Let’s start by opening the Plot Editor with an existing layout and then read a new
layout from the Plot Editor interface.

Exercise 17
1. Open the 1D dataset examld_1H/1/1.

2. Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected).

3. Enter pl ot . The Plot Editor interface will appear, showing the spectrum
according to the layout 1D_H.xwp (see Figure 6.5).

Now let’'s ook at the same dataset with a different layout.

4. Click File— Open [Ctr | +0]
5. In the appearing dia og:

a) Navigate to the layout directory <tshome>/plot/layouts L)
b) Select or enter the layout 1D_H+pp.xwp.

c) Click Open

1) <tshome> is the ToPsPIN home directory (default C:\Bruke\TOPSPIN under Windows and
and /opt/topspin under Linux).
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.

,I BH‘I:IKEH
LU itk
B e

Figure6.5

6. Inthe Plot Editor interface;

a) Click File— Print [Ctr | +p], select the printer in the appearing dialog
and click Print.

b) Click File— Exit to close the Plot Editor.

The plot on the paper should be the same as the white area in the Plot Editor inter-
face.

6.4 Saving modified layouts

If you have modified an existing layout or created a new layout, you can saveit for
later usage. M odified Bruker layout can be saved, under a different name or under
the same name, in adifferent directory.
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6.4.1 Saving a Bruker layout

Bruker layouts are write protected. Modified Bruker layout can be saved under a
different name or in a different directory.

To save a Bruker layout under a different name:
7. Click File - Saveas...
8. In the appearing diaog:
a) Specify or select alayout filename.
b) Click Save.

To save a Bruker layout under the same name, in a different directory:
1. Click File - Saveas...
2. In the appearing dialog:
a) Navigate to the desired directory
b) Click Save.
The second possibility allows you to easily run |CON-NMR with your own layouts,

e.g. with your company logo, using Bruker experiments. Note that you need to set
the layout search path to do this (see paragraph 6.2.1).

1)

6.4.2 Saving a User defined layout

User-defined layouts are writable for the user who created them. You can save
your own layouts as follows:

1 Click File » Save [Ct r | +s ] to save the layout under the same name, over-
writing the current file.

or

1 Click File —» Save as.... to save the layout under a new name.
In the appearing dia og:
a) Navigate to the desired directory.
b) Click Save.

If you exit the Plot Editor without having saved a modified layout, you will be

1) Thisdirectory must be added to the layout search path in User Preferences (command set )
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6.4.3

prompted to save it first.

Saving aBruker or User-defined Layout in the Dataset

Plot Editor allows you to store the layout used on a particular dataset, in that data-
set. As such you can to archive your datawith the used layout or copy them to
another user or computer.
To save the layout to the dataset:
1. Click File— Save Layout/Portfolio to Dataset.
2. Inthe appearing dialog:
a) Enter afilename or accept the default name | ayout . xwp.
b) Click Save

Note that this will not only save the layout but also the current portfolio under the
filename port fol i o. por.

The default storage directory isthe PROCNO subdirectory of the current dataset
(the first dataset in the Data Set Selector). You can however, navigate to any direc-
tory and store the layout and portfolio there.

6.5 Creating New L ayouts

In this paragraph we will create a new layout from scratch. So we'll start with a
blank layout areaand insert NMR and Sandard objects.

Exercise 18
1. Open the 1D dataset examld_1H/1/1
2. Enter pl ot . The Plot Editor interface will appear.
3. Click File—> New
A new empty layout will appear.?
4. Make sure theradio button NMR at the left of the Plot Editor interfaceis

1) On a Windows computer, the original layout is still available in the W ndow menu.
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enabled (see Figure 6.6).

" SBtandard

Figure 6.6

5. Create NMR objects asfollows:
a) Click the 1D Spectrum icon:

Place the cursor somewhere in the lower |eft part of the layout
area. Click-hold and move the mouse to draw the Spectrum ob-
ject and release the mouse.

a) Click the 1D FID icon:

Place the cursor in the layout area somewhere above the Spec-
F trum object. Click-hold and move the mouse to draw the FID
object and rel ease the mouse.

b) Click the Titleicon:

Place the cursor in the layout area, click-hold and move the
Title mouse to position the Title object, e.g. in the upper left corner,
and rel ease the mouse.

c) Click the Parametersicon:

Place the cursor in the layout area, click-hold and move the
mouse to position the Parameters object, e.g. in the lower right
corner, and release the mouse.

|

L
11

€ You can click-hold any object and move the mouse to change its position

6. Click the radio button Standard at the left of the Plot Editor interface (see
Figure 6.6).

d) Click the Text icon;

Place the cursor in the layout area at a position near the Spec-
ABC object. Left-click and enter any text string as annotation.
abc M ove the mouse to adjust the object position (if necessary) and
left-click to fix it.

e) Click the Linesicon:
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Place the cursor in the layout area, just below the annotation

>¢. Text object. Click-hold and move the mouse to draw aline ob-
ject. Double-click the Lineobject, select the upper-right (arrow)
Type and click OK to turn the line into an arrow.

f) Click the Metaicon:

Place the cursor in the upper right corner of the layout area.
iWeta Double-click the Meta object 1), click the Browse button in the
appearing dialog and select the file <tshome>/plot/layout/meta/
bruker.wmf 2 or any other . wif or . enf fileand click OK.

7. Click File— Print [Ct r | +p] to print the layout. The printout on paper
should be exactly the same as the white areain the layout area.

8. Now save the new layout for later usage: click File —» Save As... enter a
filename with the extension .xwp and click Save.

9. Click File— Exit to leave the Plot Editor.

-

ERUKER

-

Figure 6.7

1) On Linux systems, click the EPSI icon and browse for an EPSI file (see also Chapter 11).
2) <tshome> is the ToPsPIN home directory (default C:\Bruker\TOPSPIN under Windows and
and /opt/topspin under Linux).
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6.6 Modify an existing layout

Layouts can be modified by adding, manipulating or removing objects as
described in Chapter 5.

6.7 Printing the current layout

The graphics created by the PLOT EDITOR can be printed from the Plot Editor inter-
face of from the TopspiN command line.

Printing a Layout from the Plot Editor interface

1. Click File— Print[Ctr] +p].
2. In the appearing dialog:

a) Select the printer.

b) Optionally: click To File, if you want to store the output into afile g
rather than send it to the printer.

¢) Click Print

Printing a Layout from the TopsPIN command line

1. Enter | ayout . Inthe appearing dialog, select the desired layout.
2. Enter aut opl ot .

6.8 Exporting the current layout

PLOT EDITOR allows you to export the layout area to various graphicsformats like
EMF, PS, PDF and PNG. Exported files can be imported by other applicationslike
Word, Coreldraw, Powerpoint etc. To export the current layout:

1. Click File —» Export..

2. Select or enter the name and type of the export file in the appearing dialog
and click Save.

Details on exporting graphics can be found in Chapter 10.

1) The plot is saved in the natural printer format according to the printer setup.






Chapter 7

Plotting In Automation

NMR data are often acquired, processed and plotted in automation, using |CON-
NMR and/or Python or AU programs. Plotting in automation uses the same plot lay-
outs and portfolios used for the interactive Plot Editor. Furthermore, plotting in
automation uses the so called Reset Actionsto control plot regions, intensity scal-
ing and baseline positions.

7.1 ICON-NMR automation flow

To fully understand how plotting in automation works, we'll briefly look into the
|CON-NMR automation flow. ICON-NMR allows you to measure a series of samples,
defining one or more Experiments for each sample. Experiments are defined by
parameter sets, which contain acquisition and processing parameters. For each
experiment, ICON-NMR runs two AU programs, one for acquisition and one
processing/plotting. Let’sfirst define a few things:

Experiments

Experiments are parameter sets, which define the experiment to be performed.
They contain parameters for acquisition and parameters for processing/plotting.
The parameters used for plotting in automation are:

e AUNMP - the AU program used for processing and plotting
e F1P/F2P - the plot limits defining the region to be displayed/plotted
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e CY -theintensity scaling factor (cm)
« LAYOUT - the plot editor layout to be used for plotting

Examples of frequently used Bruker experiments are PROTON for 1D experi-
ments and COSY 45SW for 2D experiments. For each experiment, |CON-NMR cre-
ates a dataset directory with the acquisition and processing/plotting parameter
files.

AU programs

AU programs are automation programs executed to acquire or process/plot data.
The AU program that acquires the raw data is defined by the parameter AUNM.
The AU program that processes and plots the data is defined by the parameter
AUNMP. Examples of frequently used Bruker AU programsareau_zg for acqui-
sition, pr oc_1d for 1D processing/plotting and pr oc_2dsymfor 2D process-
ing/plotting. AU programs can be viewed/edited with the command edau.

AU macros

AU macros are AU program statements. Bruker AU programs for processing/plot-
ting contains processing macros like EF and APK and plot macros like AUTO-
PLOT. Further plot macrosare AUTOPLOT_WITH_PORTFOLIO and
ADD_TO_PORTFOLIO. TopspIN 2.0 and newer also contain macros for auto-
matic creation of layouts (see Help - Manuals — Programming manuals — Plot
Layout Programming)

Plot layouts

A plot layout is atemplate defining graphical objects, used for interactive and
automated plotting. |CON-NMR plots a dataset according to the layout defined by
the parameter LAY OUT. Examples of frequently used layouts are 1D_H.xwp for
1D dataand 2D_hom.xwp for 2D data.

The interaction between these elementsinvolved in plotting in automation is
shown in Figure 7.1.
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7.2 User defined layouts in automation

In TopspPIN 2.0 and newer, the commands pl ot and aut opl ot useaconfig-
urable search path to locate the specified layout.

This feature has important advantages. It allows you to:
 store layouts on a central server in the network
e use Bruker standard experiments and plot with your own layouts

Suppose you want to use the standard Bruker experiments, but use modified plot
layouts, e.g. with your company logo. Now you can simply modify Bruker layouts,
store them, under the same name in a different directory. The storage directory
must be added to the search path in the User Preferences (command set ). If the
layout specified by the parameter LAY OUT existsin this directory, it is used, oth-
erwise the standard Bruker layout is used.

Exercise 19

1. Enter new, define anew (dummy) dataset in the appearing dialog and click
OK to createiit.

2. Makealist of Bruker experiments (parameters sets) that you will usein
ICON-NMR (enter r par to get alist of all experiments).

3. For each experiment, find out which Bruker layout it usesfor plotting. To do
that:

a) Enterrpar <experinment _name> all
b) Enter | ayout

Probably many experiments will use the same plot layout.

Now perform step 4 to 7 for each layout.

4. Enter | ayout onthe command line. Inthe appearing dialog, select the cho-
sen layout.

5. Enter pl ot to open the Plot Editor interface.
6. Modify the Bruker layout according to your wished (see Chapter 5).

7. Click File— Save and store the modified layout in a directory different
from <tshome>/plot/layouts, e.g. C:\plot_layouts.

8. Click File— Exit to close Plot Editor.
9. Run ICON-NMR experiments. The data will be plotted with the modified lay-
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outs.
10.Note that layout search path may contain multiple directories, e.g.:

Under Windows C: \ pl ot _| ayouts; D:\ 2D | ayouts

Under Linux: / opt / t opspi n/ | ayout s: / home/ nnv/ ny_| ayout s
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7.3 AU macrosfor plotting

Plot macros

AUTOPLOT

AUTOPLOT_TO_FILE

AUTOPLOT_WITH_PORTFOLIO

AUTOPLOT_WITH_PORTFOLIO_TO_FILE

Plot the current data according to the layout
defined by LAYOUT.

Plot the current data to afile according to the
layout defined by LAY OUT.

Plot the data in the portfolio created by
CREATE_PORTFOLIO.

Plot the data in the portfolio, created with
CREATE_PORTFOLIO, to afile.

Portfolio macros

CREATE_PORTFOLIO(pathname)

ADD _TO_PORTFOLIO(d, u, n, e, p)

ADD_CURDAT_TO_PORTFOLIO
CLOSE_PORTFOLIO

Create and activate the portfolio specified by
the pathname.

Add to the active portfolio the dataset speci-
fied by the dir, user, name, expno and
procno.

Add current dataset to the active portfolio.
Close the active portfolio.

Layout macros

LAYOUT_ADD
LAYOUT_ADD_1D_OBJECT
LAYOUT_ADD_PARAMETERS
LAYOUT_BEGIN_FILE
LAYOUT_END_FILE
LAYOUT_FORMAT
LAYOUT_OBJ 1D
LAYOUT_OBJ PARAMETERS
LAYOUT_OBJ TITLE

Add object to current layout.

Add 1D object to current layout.

Add Parameters object to current layout.
Open layout file.

Close layout file.

Define layout format.

Define 1D object.

Define Parameters object.

Define title object.
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7.4 Plotting from AU programs

AU programs are mainly used by |CON-NMR automation. They can, however, also
be executed from the ToPsPIN command line. Plotting in AU programsisdonein
form of AU macros. There are macros for plotting the data, handling portfolios and
creating layouts. Probably the most important macro is AUTOPLOT, which exe-
cutes the command aut opl ot and plotsthe current dataset according to the lay-
out defined by the parameter LAY OUT. A simple AU program for plotting the
current dataset is created in the following exercise.

Exercise 20
1. Open the 1D dataset examld_1H/1/1.

2. Select acertain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

3. Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected).

4. Enter edau ny_pl ot _au
5. In the appearing editor:
a) enter thefollowing two lines:

AUTOPLOT
QUIT

b) save and quit the editor.
6. Entermy_pl ot _au
The current dataset will be plotted according to the chosen layout.

Notethat thisisatrivia example for exercise purposes only. It does exactly the
same as the command aut opl ot entered on the command line.

A practically useful example isthe Bruker standard AU program pr oc_1d, used
for processing and plotting standard 1D experiments. Let's have alook at this AU
program.
Exercise 21

1. Open the 1D dataset examld_1H/1/1.

2. Select acertain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.
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3.

4,

Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected).

Enter edau proc_1d

Just scroll through the AU program code and note the macro AUTOPLOT at
the end. Close the editor.

Enter pr oc_ 1d to execute the AU-program.

The current dataset will be processed and plotted according to the chosen lay-
out.

Now let’s create a new AU program using various plot related macros.

Exercise 22

1
2.
3.

Open the 1D dataset examl1d _1H/1/1.
Enter wr p 2 and wr p 3 to create the PROCNO’s 2 and 3.

Select a certain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D+1D+1D.xwp.

Enter edau ny_pl ot _au
In the appearing editor:
a) Enter the following lines:

CREATE_PORTFOLIO("/tmp/myPortfolio.por") D
ADD_CURDAT_TO_PORTFOLIO

IPROCNO

ADD_CURDAT_TO_PORTFOLIO

IPROCNO

ADD_CURDAT_TO_PORTFOLIO
CLOSE_PORTFOLIO

DPROCNO

DPROCNO

AUTOPLOT_WITH_PORTFOLIO
AUTOPLOT_WITH_PORTFOLIO_TO_FILE("/tmp/myPlot.pdf")
QUIT

1) Use straight quotes because with so called smart quotes the AU program might not compile.
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b) Save and close the editor.
7. Enter ny _pl ot _au onthe TopsPIN command line.

ThisAU program will plot the PROCNO’s 1, 2 and 3 on one sheet according to the
layout 1D+1+1D.xwp. The plot will also be stored in a Postscript file.

7.5 Plotting from AU programsto Postscript or PDF

Data can be plotted from an AU program to afile, e.g. a Postscript of PDF file, by
using the respective macros, or arguments.

Using macros

The following macros send the plot to afile rather than to the printer:
AUTOPLOT_TO_FILE
plot the current dataset to afile. Executes the command aut opl ot - e.
AUTOPLOT_WITH_PORTFOLIO_TO_FILE

plot the dataset(s) in the portfolio created with the macro CREATE_PORTFOLIO
toafile.

The AU program ny _pl ot _au in paragraph paragraph 7.4 shows an exampl e of
using the second macro.

Using arguments

AU programs that contain the regular AUTOPLOT macro send the plot to the
printer. They can additionally send the plot to afile by entering the AU program
name with one of the following arguments:;

a - store the output in the current dataset PROCNO, in a PDF file named
emai | _<nanme>_<expno>_<procno>. pdf

e - store the output in the current dataset PROCNO, in a Postscript file named
emai | _<nane>_<expno>_<procno>. ps

h - store the output in the users home directory, in a Postscript file named
nnr _<name>_<expno>_<procno>. ps

t - store the output in the system TEMP directory, in a Postscript file named
nnT _<name>_<expno>_<procno>. ps
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You can use multiple argumentsto send the plot to multiple files. For example, the
following command entered on dataset examl1d_1H/1/1:

proc_1d a e

will processthe current 1D dataset and store the plot in the files
emai | _exanld 1H 1 1. pdf andemail|l _exanmld _1H 1 1. ps.
Please note the following:

« storing the plot in afile by using command line arguments is an additional
action, i.e. the plot is also send to the printer.

e e anda are argumentsto AU programsthat contain the AUTOPLOT macro,
whereas - e and - a are argumentsto the aut opl ot command.

7.6 Preventing an AU program from plotting

AU programsthat contain macros for plotting can be prevented from plotting with
the argument nopl ot . Thiscan be useful if you want to use a standard processing
AU program for processing only. For example, the command:

proc_1d nopl ot
processes the current 1D dataset but does not plot it.

In TopspPIN 2.0 and newer, ICON-NMR can be configurated to plot data or not (see
ICON-NMR Configuration — Master Switches — Processing Control).

7.7 Setting thetarget printer

By default, the aut opl ot command uses the printer defined in the layout or, if
this does not exist, the system default printer. You can, however, override this with
the printer defined by the parameter CURPLOT by using the - ¢ argument. In AU
programs, you can do that with the following statements:

STOREPAR("CURPLOT", "<printername>");
CPR_exec("autoplot -c", WAIT_TERM);

Just use these two statements in your AU program instead of the AUTOPLOT
macro.
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7.8 Printing individually scaled integral regions (plotx)

TopspPIN supports printing individually scaled integral regions. This task is per-
formed by the pl ot x D command. Each integral region is plotted as a separate 1D
Spectrum object. Regions with relatively small peaks are scaled up, with the inten-
sity scaling factor, e.g. x5 or x10, being specified at the lower right of the object
(see Figure 7.2).

] =10
T T T T T T i kil R |
E I T I PEm 7.2 PR B.1 FRpm
Figure7.2

The axis scaling (Hz/cm) is the same for each integral region (object) and can be
set by the user. The output can be shown in the Plot Editor interface or can be send
to the printer. pl ot x requires prior integration (command i nt ) and peak picking
(command pp).

The command pl ot x takes up to four arguments:

pl ot x [<axes scal i ng>] [aut 0] [A3] [noi nt egral s]

where:

1) Similar tothe pl ot X command in TOPSPIN’s predecessor X WIN-NMR.
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<axes scal i ng>isthe X-axis scaling factor (default 100 Hz/cm)

aut o isaflagindicating to send the output to the printer rather then to the Plot
Editor interface.

A3 isaflagindicating to use A3 format rather than A4.
noi nt egr al s isaflag to prevent integral labels and trails to be printed.
Here are some examples:
pl ot x

plots each integral region with 100 Hz/cm showing the output in the plot ed-
itor interface.

pl ot x 50

plotseach integral regionwith 50 Hz/cm showing the output inthe plot editor
interface.

pl ot x auto
plots each integral region with 100 Hz/cm sending the output to the printer.
pl ot x 200 auto A3 nointegrals

plots each integral region with 200 Hz/cm sending the output, without inte-
gral trails/labels, in A3 format to the printer.

Depending on the number and width of the integral regions, one or more sheets
(layouts) are required. Without the aut o argument, pl ot x opens the Plot Editor
showing all layouts. The output depends on your operating system. Under Win-
dows, all layouts are shown, cascaded, in the same Plot Editor window (see Figure
7.3). You can change the window arrangement from the Window menu. Under
Linux, the different layouts are shown in separate Plot Editor windows.

pl ot x isactualy an AU program. If you are familiar with AU programming, you
can modify it to your specific needs. Just enter edau pl ot x, make your changes
and store it under a different name.
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i plotx-output-1.xwp
i plotx-output-3.xwp
| plotx-output-2.xwp
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Figure7.3

7.9 Creating layoutsfrom AU programs

TopspPIN 2.0 and newer supports automated layout creation. It allows you to create
aplot layouts with an AU program. Various AU macros can be used to create lay-
out objects, i.e. Title, Parameters, 1D spectrum, NMR Text, etc. In the following
exercise, we'll write an AU program for creating asimple plot layout and show the
result

Exercise 23
1. Open the 1D dataset examld_1H/1/1.
2. Enteredau ny_au_l ayout 1
3. In the appearing editor, enter the following lines:

#i ncl ude <inc/|ayout_package>

LAYOUT_FORMAT ny_format = LAYOUT_FORMAT_DEFAULTS;
LAYOUT_OBJ_1D my_obj = LAYOUT_1D DEFAULTS;
LAYOUT_BEG N_FI LE("c:\\tenp\\pl ot.xwp", my_format);
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LAYOUT _ADD 1D OBJECT(ny_obj):
LAYOUT _END FI LE;
QT

4. Save and close the editor.

5. Enterny_au_| ayout 1

6. Enterplot -r C.\TEMP\ pl ot . xwp

Theresult is shown in Figure 7.4.

TN A LL\N ‘

10 3 8 T 3 5 4 3 2 ! 0 ppm

Figure 7.4

A list of layout creation AU macros can be found in paragraph 7.3. Note that they
al start with LAY OUT _. Detailed information on automatic layout creation and
more example AU programs can be found under Help — Docs — Programming
manuals — Plot Layout Programming.



Chapter 8

Reset Actions

8.1 What are Reset Actions

Reset actions are a set of rules, which control the appearance of individual Spec-
trum or FID objects, by either using or overruling experiment parameters. They
influence:

e theX and Y limits of the displayed region
e theintensity scaling
e the spectrum and integral baseline positions

@ Reset actions are object specific and stored in the layout.

Reset actions are mainly used in automation to ensure proper plot regions and
intensity scaling. They are automatically performed by the command aut opl ot
which isused for plotting in ICON-NMR automation and AU programs. Reset
actions can, however, also be applied in interactive plotting by opening the Plot
Editor with pl ot -r.

Reset actions only apply to the NMR objects which hold spectral data, i.e. 1D
spectra, 2D Spectra, FID and Stacked Spectra. For all other NMR objects as well
as Standard objects, Reset Actions do not exist (the - r argument has no effect).
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8.2 Reset actionson 1D spectra

Reset actions play an important rolein plotting 1D spectrain automation. They are
mainly used to control the plot region and intensity scaling. Let’s have a closer
look at this in the following exercise.

Exercise 24
1. Open dataset examld_1H/1/1.

2. Enter| ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp (if it is not already selected).

3. Enter pl ot to open the Plot Editor interface.

4. Right-click in the Spectrum object and choose Automation from the popup
(see Figure 8.1)

Edit ...

Axis Tick Settings. ..
Attributes ...

Cut
Copy

Delete
Duplicate

Raize
Lower
Rotate

< Reset Ohject >

Figure8.1

This will open the dialog shown in Figure 8.2.
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Figure 8.2

It showsall possible Reset actionsfor the X and Y limits, theintensity scaling

and the baseline positions.

The nature of the Reset Actions are explained below. Let’s first make some
changes and look at the effect.

5. Change any Reset Actionsyou like and click OK to store them.

6. Right-click inthe object and choose Reset Object from the popup menu (see
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Figure 8.1) to see the effect of the changes. Depending on what you
changed, the plot region, intensity scaling or baseline positions will be
adjusted.

Now |et’s see how this works.

Reset Action for the X dimension

Don‘t change
No reset action. Keep the X-limits defined in the layout. Useful for, e.g., PRO-
TON spectrawith fixed plot limits (e.g. 9 - (-1) ppm).

Set to minimum/maximum

Set the X-limits to the minimum /maximum chemical shift, i.e. plot the entire
spectrum. Useful for, e.g., heteronuclear spectrawith very different plot areas
(13C, 15N, ..).

Set to F1P/F2P

Set the X-limits to the processing parameters F1P/F2P, i.e. the plot the region
displayed in the TopspPIN data window. Useful for, e.g., automation (FIP/F2Pis
set in the AU program) or interactive plotting (F1P/F2P is set in the TOPSPIN in-
terface).

Reset Action for theY dimension

Don‘t change
No reset action. Keep the Y-limits defined in the layout. Useful for, e.g., kinetic
experiments (absol ute intensity mode).

Set to minimum/maximum
Set the Y-limits to the minimum /maximum intensity, i.e. the scaling reference
peak isthe highest peak in the entire spectrum. Useful for, e.g., DEPT spectra.

Set to minimum/maximum between Xmin/Xmax

Set the Y-limits to the minimum /maximum intensity between Xmin/Xmax, i.e.
the scaling reference peak is the highest peak in the region defined by the Reset
action for the X-direction. Useful for, e.g., automatic plots of small spectral re-
gions.

Useregion file on reset

Checkbutton to enable/disable the usage of aregion file for determining the scal-
ing reference peak.
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e intrng
Usethe integral rangesfilei ntr ng D, created by abs or interactive
integration. Useful for, e.g., interactive plot setup.

* reg
Usetheintegral rangesfiler eg D, created by interactive integration.
Useful for, e.g., interactive plot setup.

« Defined by sreglst
Use the scaling regions file 2) defined by the parameter SREGL ST. Use-
ful for, e.g., automation to exclude the solvent peak.

After reset, size of biggest peak (scaling reference peak) is:

e % of plot size: set to use the entire Y-dimension. Useful for, e.g., auto-
matic plot of, e.g. NOEDIFF spectraor for plotting small signals.

e absvaluein cm: enter the absolute value
« defined by parameter CY: set to the value of the parameter CY

After reset, size of biggest integral is:
e absvaluein cm: enter the absolute value

Baselines

« Keep zero line fixed on: keep the spectrum baseline fixed on the specified
percentage of the object bounding box

« Keepintegralsfixed on: keep the integral baselines fixed on the specified
percentage of the object bounding box

The effect Xmin/Xmax and Y min/Y max reset action can be seen in the graphical
object as the displayed region. The exact limits can be seen in the Object editor.
Let’shave alook at these:

7. Right-click in the object and choose Edit. The displayed limits are shown in
the Plot section under the Graph pane (see Figure 8.3).

1) To see thisfile: right-click in the TopsPIN data window and choose Files..
2) To seethisfile, enter edl i st scl and click the list defined by the parameter SREGLIST
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Figure 8.3

Exercise 25
1. Open the 1D dataset examld 1H/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window

and drag the cursor line along the desired region.

3. Enter | ayout onthe command line. In the appearing dialog, select the

standard layout 1D_H+zoom.xwp.
4. Enter pl ot

The layout will contain two Spectrum objects with the same spectral region (see

Figure 8.4).
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Figure8.4

Obviously this does not make much sense. So we'll do this again using the Reset
Actions.

5. Click File — EXxit to leave the Plot Editor.
6. Enter pl ot -r to start the Plot Editor with Reset Actions.

Now the layout will show one Spectrum object with the full spectrum and one with
the selected region, which isthe purpose of thislayout (see Figure 8.5).

Note that the Reset Actions are defined in the layout, for each individual object.
They can be viewed/set from the Plot Editor interface.

7. Right-click in the lower Spectrum object and choose Automation from the
popup. Thiswill open adialog showing the Reset Actions of this object. The
upper part of this dialog shows the Reset actions for the plot region Xmin/
Xmax (see Figure 8.5). Note that for this object it is set to minimum/maxi-
mum, i.e. the full spectrum. Click OK to close the dialog.
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Figure 8.5

Rezet action for #mind<mas

8. Repeat step 7 for the upper Spectrum object and note that the Reset Actions
for Xmin/Xmax are set to F1IP/F2P, i.e. to the zoomed region. Click OK to
close the dialog.

9. Click File— Exit to leave the Plot Editor.
10.Enter autoplot

Sinceaut opl ot performsthe Reset Actions, the output will look the same asthe
output of pl ot -r.

Let’s take another example of using Reset Actions.

Exercise 26
1. Open the 1D dataset examld 1H/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

3. Enter | ayout onthe command line. In the appearing dialog, select the
standard layout 1D_H.xwp.

4, Enterplot -r

5. Right-click in Spectrum object and choose Automation from the popup.
This will open adialog showing the Reset Actions of this object. Note that
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the selected reset action for Y min/Y max is Set to minimum/maximum
between Xmin/Xmax. As such, the scaling reference peak is the highest
peak in the plotted region (see the upper part of Figure 8.6).

Rezet action for v minymas

" Daon't change

" Set bo minimunnmaximunm

*  Set to minimumn/mazimum between 2mind

VL /\ML

540 53 s ppm

Rezet action for ¥minmas

" Daon't chanage

" Set to minimummasimum between Hmindsmax

kb_/\f\/’k,«

18 ppm

Flgure 8.6

6. In the Automation dialog:
a) Changethe Reset action for Y min/Y max to Set to minimum/maximum
b) Click OK

7. Right-click in Spectrum object and choose Reset Object.
Seehow the Y expansion has changed according to the new settings of Y min/

Y max. The scaling reference peak is now the highest peak in the entire spec-
trum (see the lower part of Figure 8.6).



154

Reset Actions

8.3

8. Click File — Exit to close the Plot Editor interface. Do not save the layout.

The above exampl e just shows the use of Reset Actionsfor X and Y expansion.
However, Reset Actions are also used for the use of region files, scaling of the big-
gest peak and position of the spectrum and integral baseline.

Performing Reset actions

8.3.1

8.3.2

Reset actions are usually performed automatically when spectra are plotted during
ICON-NMR Automation. They can, however aso be performed from the ToPSPIN
command line or from the Plot Editor interface.

Reset actionsin automation

In automation, plotting is performed by one of the AU macros:
« AUTOPLOT

« AUTOPLOT_TO FILE
« AUTOPLOT_WITH_PORTFOLIO
« AUTOPLOT_WITH_PORTFOLIO TO FILE

These macros all execute the command aut opl ot , which automatically per-
forms Reset Actions on all Spectrum objects of the current layout. A such, plotting
in automation is always performed with Reset Actions.

Reset actions from the command line

Plotting from the command line can be performed with the commands pr nt ,
pl ot and aut opl ot . The command pr nt simply prints the data window. It
does not use a layout, and as such, performs no Reset Actions. For pl ot and
aut opl ot it depends on the argumentsif Reset Actions are done or not.

Here iswhat happens:
e prnt - nolayoutinvolved, so no Reset Actions
e autopl ot - ResetActionson al objects of the layout
e autoplot -f -noResetActions
e pl ot -noReset Actions
e« plot -r -ResetActionson all objects of the layout
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8.3.3 Reset Actionsfrom the Plot Editor

Reset actions can be performed interactively from the Plot Editor. Thisistypically
used to test the effect of certain Reset Actions, before saving alayout. They can be
performed on individual objects or a group of objects.

To perform Reset Actions on one Spectrum object:

1= Right-click in the Spectrum object and choose Reset Object
To perform Reset Actions on all Spectrum objects:

1= Click Edit — Reset all objects

To perform Reset Actions on multiple Spectrum objects:
1. Mark the Spectrum objects.
2. Click Edit —» Reset Marked objects[Ct r | +t ]

To get the current dataset and perform Reset Actions on all Spectrum objects:
1> Click TOPSPIN — Get Current Data Set + Reset

To get the current dataset, perform Reset Actions on all Spectrum objects and
print;

1 Click TOPSPIN — Get Current Data Set + Reset +Print

8.4 Reset actionson stacked plots

Reset actions on Stacked Plots are basically the same as on 1D spectra. They apply
on al spectradisplayed in the stacked plot. Since these spectra may differ in sweep
width and/or chemical shift offset, the following rules:
For Reset Action for X = Set to minimum/maximum
e The X-limits are set such that the full sweep width of each spectrumis
displayed.
e Thereference peak for intensity scaling is the highest peak in all of the
spectra.
For Reset Action for X = Set to F1P/F2P and Reset Action for Y is Set tomin-
imum/maximum between Xmax/Xmin

e The X-limits are set to the values of F1P/F2P of the first spectrum



156 Reset Actions

« Thereference peak for intensity scaling is the highest peak in the first
spectrum.

The following examples demonstrate this.
Example 1
A stacked plot of the following two spectra:

Spectrum 1: 100 - 50 ppm
Spectrum 2: 80 - 0 ppm

The highest peak isfound in spectrum 2, at 30 ppm.
The Automation Reset Actions are set as follows
Reset Action for X = Set to minimum/maximum
Reset Action for Y = Set to minimum/maximum between Xmin/Xmax
Size of biggest peak is10 cm
After Reset, the Stacked Plot object will show:
e The X-axiswill run from 100 - O ppm
e TheY-axisissuch that the peak at 30 ppm in spectrum 2 will be 10 cm
Example 2
A stacked plot of the following two spectra:

Spectrum 1: 100 - 50 ppm, F1P = 95 ppm, F2P = 55 ppm
Spectrum 2: 80 - 0 ppm, F1P = 35 ppm, F2P = -5 ppm

The highest peak isfound in spectrum 2, at 30 ppm. Spectrum 1 containsa some-
what smaller peak at 70 ppm.

The Automation Reset Actions are set as follows
Reset Action for X = Set to F1P/F2P
Reset Action for Y = Set to minimum/maximum between Xmin/Xmax
Size of biggest peak is10 cm

After Reset, the Stacked Plot object will show:
e The X-axiswill run from 95 - 55 ppm
e TheY-axisissuch that the peak at 70 ppm in spectrum 1 will be 10 cm
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8.5 Reset actionson 2D spectra

Reset actions on 2D spectra are basically the sasme ason 1D spectra. The differ-
enceisthat both X and Y limits refer to the spectral regions in the respective direc-
tions. The 1D Y-limits and intensity Reset Actions are now used for projections.
They can be set separately for the top, bottom, left and right projection. Figure 8.7
shows the default Reset Actions for the layout 2D _inv.xwp, which isthe layout of
several standard Inverse experiments.

Automation Action g|
20 Spectium ]

Feset action for gues
Hmingd<man [F2]: mingmanF1)
" Don't change " Daon't change

" Set to minimurm,masimum " Set bo minimunmaximum
: f+ Setta FIPLO / F1PHI

Rezet action for projections

& top © bottorn O left O right
" Don't change

" Set to minimurm,masimum
' Set o rminimurmnmasimum bebwesn Hmindmnas

v Usze region file on reset:
g O intng ©* defined by SREGLST

After reset, size of biggest peak iz

fe| 10000 % of plat size 200 em

QK | Cancel | | Help

Figure 8.7

8.6 Reset actionson FIDs

Reset actions on FIDs are basically the same as on 1D spectra, except that the X-
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limits cannot be set to F1P/F2P and there are no Reset Actions for intensity scal-
ing. Figure 8.8 shows the default FID Reset Actions.

Automation Action g|
FID |
Reset action for Hmind<man

" Don't change

(% Set to mirimum, masimnue

Reset action for vminSyman

" Don't change
{* Set to minirmur, masimurm

" Set ta minimum/maximum between Xmind<ma

QK | Cancel | | Help

Figure 8.8

8.7 Reset actionson T1/T2 objects

Limited reset actions can be performed on T1/T2 objects. They only set the X- and
Y-limits to Minimum/Maximum. Note that in this case the reset actions can be exe-
cuted but not set (choosing Automation from the right-click popup menu has no
effect).



Chapter 9
Preparations

Before plotting interactively with the Plot Editor, data must be prepared to meet
the plot requirement. This includes data processing, integration, etc., aswell as
defining a plot title and aplot layout. Note that peak picking is automatically per-
formed during Plot Editor startup. In ICON-NMR automation, all information is
defined in the Experiments and all preparatory steps are performed automatically.

9.1 1D data

9.1.1 Processing thedata

If the current dataset only contains raw data, please use TOPSPIN processing com-
mandslikef t f, ef , apk etc. to create processed data. Then use the commands
pl ot or aut opl ot to print the data.

9.1.2 Defining the plot region

If you want to plot a certain spectral region rather then the full spectrum, you have
to define the plot region first. To do that:

1= Click-hold in the data window, drag the cursor line along the desired region
an release the mouse.
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9.13

914

Note that the command pl ot will not only use the displayed region but also store
it in the parameters F1P/F2P.

Setting the plot title

In order to show the plot title on the plot, it must be set first. To do that:
1> Enter edt i on the command line
or
1> Click the Title tab of the data window

enter the plot title and save it by clicking the click the [®] button. Thetitleis
saved inthefilet it | e inthe current processed data directory (PROCNO). The
title will appear on the plot if the defined layout contains a Title object. Thisisthe
case for most Bruker standard layouts.

Defining integrals

Integral traces and integral labels can be plotted as part of an NMR Spectrum
object. However, before you can do that, integral ranges must have been deter-
mined. If the integrals are displayed in the TopspIN data window, thisis obviously
the case. If they are not displayed, they might not have been determined or they
might be selected in the display options (right-click in the datawindow and choose
Display Options, to find out).

If the integral ranges have not been determined, do the following:
1 Enter abs on the command line for automatic integration

or
i Click the _4_ button for interactive integration

Even if integral ranges have been determined, the will only appear on the plot if
they are defined in the plot layout, i.e. if they are enabled in the 1D spectrum
object properties (see Figure 5.11). Note that for some Bruker layouts (e.g.
1D_H.xwp) thisisthe case, whereas for others (e.g.1D_H+noint+ppp.xwp), it is
not.



Preparations 161

9.1.5 Defining the plot layout

The Plot Editor layout is defined by the parameter LAY OUT. To define the layout,
you must set the parameter LAY OUT as follows:

1= Enter | ayout onthe command line
or
1 Click the Procparstab and click the Automation section

Note that standard 1D layouts names start with 1D, e.g. 1D_H.xwp and

1D _X+int.xwp. If the parameter LAY OUT isnot set, the command pl ot will still
work taking the default layout (Plotl). aut opl ot , however, will give an error
message if no layout is set.

9.1.6 Plotting the data

After performing the above steps, you are ready to plot the data using the com-
mands pl ot or aut opl ot .

Notethat if preparatory steps have not been done, plotting will still work but some
graphical objects of parts of them might be missing.

9.2 2D data

9.2.1 Processing data

If the current dataset only contains raw data, please use TOPSPIN processing com-
mandslikef t f, xf b etc. to create processed data.

9.2.2 Defining the plot layout

Define the layout to be used by setting the parameter LAY OUT. To do that, enter
| ayout onthe command ling, click the Procpars tab. Note that standard 2D lay-
out names start with 2D, e.g. 2D_hom.xwp and 2D_inv.xwp.

9.2.3 Setting thePlot Title

To set the plot title, enter edt i on the command line or click the Title tab of the
data window, enter the plot title and save it by clicking the click the [®] button.
See the also paragraph 9.1.3).
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9.2.4 Defining projections

To define the projections of a 2D dataset do the following:

1. Clickthe 4 toolbar button to display the projections (if these are not dis-
played yet).

2. Right-click in the data window, inside the F1-projection area, choose Exter-
nal Projection from the popup and specify the dataset examl1d_1H/1/1 as
external projection. Repeat this action for the F2-projection area.

3. Note that projections must be defined as external datasets. Plot Editor does
not display/print internal projections.
9.2.5 Settingthe Contour levels
Plot Editor uses the contour levels shown in the data window.
To set the contour levels:

1> Click the button: =% or enter edl ev on the command line and set the levels
in the appearing dialog.

or
1 Click one of the buttons =2, f2 etc., or pressAl t +PageUp/PageDown

To store the contour levels:

1= Click the E[ button of the toolbar.

9.2.6 Plotting the data

After performing the above steps, you are ready to plot the data using the com-
mands pl ot or aut opl ot .

Notethat if preparatory steps have not been done, plotting will still work but some
graphical objects of parts of them might be missing.



Chapter 10
|mport/Export Graphics

PLOT EDITOR supports full import and export of graphics. Graphicsimport into the
Plot Editor can be performed in form of EMF files (Windows) or EPSI files
(Linux). Graphics can be exported to graphics formats such as EMF, PS, PNG etc.
and to the Clipboard. Export can be performed interactively from the Plot Editor
interface or, automatically, from the command line or from an AU program.

10.1 Importing graphics

Under Windows, Plot Editor can import graphics in two formats:
* WMF: Windows Metafile format
e EMF: Enhanced Metafile Format

Both formats are scalable without loss of quality.

Under Linux, Plot Editor can import graphicsin:
e EPSI: Encapsulated Postscript Interchange format

Import is performed by creating an object containing an imported graphical file or
an object with areference to an external graphicsfile.
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10.1.1 Importing object exter nal graphics

To do that, you have to create a metafile object and connect it to a graphicsfile.
The following exercise demonstrates how to do this.

Exercise 27
1. Start TopsPIN and open any 1D or 2D dataset.
2. Enter pl ot . The Plot Editor interface will appear.
3. Click the radio button Standard at the |eft of the Pot Editor window.
4. Click thefollowing icon:

Place the cursor in the layout area at the desired position. Click-hold
Metg at that position and move the mouse to draw the metafile object.

5. Right-click in the metafile object and choose Edit from the popup menu.
6. Inthe appearing dialog (see Figure 10.1):
a) Click the Br owse button.
b) Select or enter the desired graphics file in the appearing dial og.
¢) Click OK toimport the graphics and close the dialog.
7. Click File— Saveto store the layout.
Note that the saved layout contains a reference to the graphics file, not the file

itself. If you want to use this layout, the graphics file must exist, otherwise the
metafile object will be empty.
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Edit

X]

Metafile Object l Data Set] B asic I

tetafile Type:

For thiz object the metafile data are located
in a separate file:
| Browse ...

¥ Always resize graphics to fit in boundaries

[ when resized keep original aspect ratio
[Graphics will nat get distorted]
Adapt object dimenzions on OK:
[ Baszed on #-Dimension

[ Based onY-Dimension

QK | Cancel | Apply | Help |

Figure 10.1

Instead of browsing for the graphicsfile (see Figure 10.1), you can a so specify the
pathname in one of the following ways:

» Specify absolute pathname, e.g.:
C./ TEMP/ ny_gr aphi cs. enf

e Usethe ~ character for the user home directory, e.g.:
~/ graphi cs/ ny_graphi cs. enf

e Usethe + character for the dataset PROCNO, e.g.:
+/ my_graphi cs. enf

Possible problems

The graphics file might include an entire page whereas the actual graphical object
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isonly asmall part of it (see Figure 10.2).

Figure 10.2

This problem can sometimes be solved as follows:
1. Right-click in the object and choose Edit from the popup menu.
2. Inthe appearing dialog, disable the entry:

Always resize graphicsto fit in boundaries

10.1.2 Importing object internal graphics

In order to create alayout internal graphics object, you have to copy it from the
clipboard. The following exercise demonstrates how to do this.

Exercise 28

1. Copy agraphical object from any application to the clipboard. In most
applications you can do that by selecting the graphics and pressing
Crl +c.

2. Start TopsPIN and open any 1D or 2D dataset.
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3. Enter pl ot . The Plot Editor interface will appear.

Metafile Obiect | Basic |

tetafile Type:

¥ Always resize graphics to fit in boundaries

[ Mw/'hen resized keep onginal aspect ratic
[Graphics will nat get distorted]

Adapt object dimenzions on OK:
[ Baszed on #-Dimension

[ Based onY-Dimension

For thiz object the metafile data are part of the layout file (it
onginally haz been inmparted fram the clipboard).

QK | Cancel | Apply | Help

Figure 10.3

4. Click Edit — Paste [Ct r | +v ] to paste the graphics from the clipboard.
5. Click-hold in the graphics object and move the mouse to put it at the desired

position.

6. Right-click in the graphics object and choose Edit from the popup menu.
Notethat the graphics (metafile) data are now part of the layout file and will

be saved with it (see Figure 10.3). Click Cancel to close the dialog.

7. Click File —» Save and store the layout.

10.1.3 Importing text

Just like graphics, text can be imported from afile or from the clipboard.

Importing text from afile

To import text from atext file to aplot layout, you can use the NMR Text object.
The following exercise shows how to do that.
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Exercise 29

1
2.
3.

Start TopPsPIN and open any 1D or 2D dataset.
Enter pl ot . The Plot Editor interface will appear.
Click theicon:
and click at the desired position inthe layout areato create thetext
NMR opject.
Text
Right-click in the text object and choose Edit from the popup dial og.
In the Edit dialog (see Figure 10.4):
a) Selectthe NVR Text tab
b) Click the button Browse

c) Select or enter the desired text file in the appearing dialog and click
Open.

d) Click OK to load the text file and close the Edit dialog.

Edit X

Te: ta Set] Basic I

Test File |

Browse

QK | Cancel | Apply Help

Figure 10.4
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Importing text from the clipboard

To import text from the clipboard, just copy a piece of text from any file or appli-
cation with Ct r | +c. Then paste it to the Plot Editor with Ct r | +v. The text will
appear in anew text object, which you can then move, resize, edit like any other
text object, e.g. the NMR object Title (see paragraph 5.8.2).

10.2 Exporting Graphicsunder Windows

PLOT EDITOR allows you to export the layout area to various graphicsformats like
EMF, PS, PDF and PNG as well as copy it to the Clipboard. Exported files can be
imported by other applications. Note that EMF files contain high quality graphics
but often appear distorted when they are imported in Microsoft applications like
Word and Powerpoint. PNG is usually a good choice for these applications. Copy-
ing to the Clipboard allows you to copy single objects as opposed to the entire lay-
out area.

€ PNG format is highly recommended for exporting Plot Editor graphics

PDF can be used to print the graphics on computers on which Plot Editor is not
installed.

10.2.1 Exporting a plot from the Plot Editor interface

A plot layout can be viewed, created or modified and then exported from the Plot
Editor interface. The following exercise shows how to do that.

Exercise 30
1. Start TopsPIN and open any 1D or 2D dataset.

2. Enter | ayout onthe command line. In the appearing dialog, select a suita-
ble layout.

3. Enter pl ot . The Plot Editor interface will appear, showing the chosen lay-
out.

4. Click File - Export
5. Select or enter the name and type of the export file in the appearing dialog
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(see Figure 10.5) and click Save.

Enhanced Metafile [ emf)
Postzcript File [°.pz)
Acrobat PDF [ pdf)
JPEG [*jpal

P mono [*.pox]
P+ 24 bit color [
Portable Metw
TIFF uncompressed [ k]
TIFF packed [*.tif]

Figure 10.5

6. Select or enter the sampling rate in the appearing dialog (see Figure 10.6) L)
and click OK.

File Export g|
Select daka sampling rate:
Zancel

Mote: higher resalution will create larger files
and may Force some prinkers ko deny prinking,

Figure 10.6
The default sampling rate is 360.

10.2.2 Exporting graphicsfrom the command line

Asan alternative to exporting a plot from the Plot Editor interface, you can do this
from the TopsPIN command line with the command aut opl ot usingthe - e
option.
Exercise 31

1. Start TopsPIN and open any 1D or 2D dataset.

2. Enter| ayout on the command line. In the appearing dialog, select asuita-
ble layout.

3. Enterautopl ot -e C\TEMP\ny_plot.png -x 600

1) For the EMF format, you cannot set the sampling rate, i.e. this dialog does not appear.
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4,

to export the plot to a PNG file with a resolution of 600 dpi.

Open the file my_plot.png from the Windows Explorer or Linux File Man-
ager to see the exported plot.

Note that the format of the graphics output file is determined by the file extension,
which canbe. png, . enf,. pdf etc. (seealso Figure 10.5).

10.2.3 Exporting graphicsfrom an AU program

As an alternative to exporting a plot from the Plot Editor interface or from the Top-
SPIN command line, you can do thisfrom an AU program with the
AUTOPLOT_TO_FILE macro.

Exercise 32

1
2.

Start TopsPIN and open any 1D or 2D dataset.

Enter | ayout onthe command line. In the appearing dialog, select a suita-
ble layout.

Enter edau ny_export _au
In the appearing editor, enter:

AUTOPLOT_TO_FILE("C:/TEMP/my_plot.pdf") ¥
QUIT

Close the editor saving the AU program.
Enter my _export _au to execute the AU program.

Open thefilemy_pl ot . PDF from the Windows Explorer or Linux File
Manager to see the exported plot.

10.2.4 Copying totheClipboard

PLoT EDITOR fully supports the Windows clipboard for graphics and text. Any
number of objectsin the Plot Editor layout can be copied to the Clipboard and than
pasted into other layouts or other applications. Copy & paste viathe clipboard is
faster and more flexible than exporting and importing the entire layout area.

To copy one object to the Clipboard:

1> Right-click the object and choose Copy

1) Note that the extension indicating the export format must be in lowercase | etters
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To copy al objectsto the Clipboard:
1. PressCirl +a
2. Click Edit — Copy or pressCt r | +c
Similarly you can copy marked objects to the Clipboard by cutting then from the
Plot Editor:
1= Click Edit — Cut or pressCt r | +x
Once you have copied or cut objects to the clipboard, you can paste them:
e to other PLOT EDITOR layouts
» to any other applications like Word, Powerpoint etc.
Note that a marked Text object, e.g. a Title or Parameters object, is copied to the
clipboard as graphics. In order to copy the object contents as text only, you have
to:
1. Right-click inthe Text object and choose Edit from the popup menu.
2. Click the Edit button in the appearing dialog.
3. Mark the text in the appearing dialog.
4. Right-click and choose Copy from the popup menu or pressCt r | +c.
10.2.5 Copying from the Clipboard
Graphics and text can be copied from the Clipboard to the PLoT EDITOR as fol-
lows:
1 Click Edit — Pasteor pressCt r | +v
If the Clipboard contains a graphics, a M etafile object (under Windows) or EPSI
object (Linux) is created. Just click-hold in the object and move the mouse to move
the object to the desired position in the layout. Double-click the object to edit its
properties.
Note that under Linux, there is no global Clipboard for all application.
10.2.6 Sending aplot by email

Plot Editor allows you to send the current plot graphics by Email.

To do that:
1. Click File— Send
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Your default Email program will popup showing anew empty message with
your plot added as a EMF file attachment.

2. Just fill out the recipient’s email address, a subject and body text and sent

the email .

To enable Email support, you must have installed a Smple MAPI Client on your
system. This can be:

Windows Messaging package that is provided as part of the Windows setup

Outlook Express which is part of Microsoft Internet Explorer. Please note
that here the Smple MAPI Client functionality must be explicitly enabled in
the applications options.

Any other Email program. Please refer to the related product documenta-
tion.

10.2.7 Export formats

Plot layouts can be exported in the following formats:

EMF and PS

Enhanced Metafile (EMF) and Postscript (EPSI/PS) are vector graphics.
They can be rescaled without loss of quality. However, not all graphics
applications are able to handle the complex Postscript and/or M etafile struc-
tures correctly, which may result in display errors.

PDF

Acrobat PDF format. Viewers for PDF (like Acrobat Reader) are freely
available for many different platforms D, PDF files are, internally, based on
Postscript and can be rescaled without loss of quality.

PNG

Bitmap (pixel) graphics. Allows excellent, lossless compression (no gray
pixel, A4 plot: 42 kB). Excellent scaling/rendering in Microsoft Office
applications. It can be displayed by word processing and drawing programs,
aswell as web browsers like Internet Explorer, Mozlla, and Konqueror.

PCX, TIFF
Bitmap (pixel) graphics. PCX and TIFF support lossless compression.

1) See www.adobe.com.
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» JPEG
Bitmap (pixel) graphics. JPEG compression is lossy, creating smaller files.



Chapter 11

Plot Editor under Linux

On aLinux computer, Plot Editor is basically the same as under Windows. Data-
sets, portfolios and plot layouts are interchangeabl e between the two plat-
forms.Neverthel ess, there are some differences as described in this chapter.

11.1 The menu Window does not exist

Under Linux, Plot Editor can contain one layout window only. As such, the Win-
dow menu for arranging layout windows does not exist. Multiple layouts under
Linux can still be displayed by opening multiple Plot Editor windows.

11.2 Edit dialogs under Linux

Under Linux, some Plot Editor dialogs differ from the Windows based dialogs
shown in this document. Where the dialogs under Windows have Tabs to show dif-
ferent parts of the dialog (see for example Figure 5.10), under Linux all parts of the
dialog are shown simultaneously (see Figure 11.1 and internally).
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b4 Edit Display Object

x
Basic: A1

Position (cm): 0x29

Dimension (em): |[19.74% 158

Attributes: Hasic

Graph:

Xmin, Xmax: |i11.008 , -1.00806

Ymin, Ymax: |-784000 , 1.60164e+07

7 Axis on Bottom _| Axis on Top

_| Ausis on Left _| Axis on Right
_| ¥-Grid | ¥-Grid

0.2 0.2
I JE I JR
A-fes Offset{cm) Y-Axes Offset (cm)

_| Scale Bounding Box

_| Draw Box around Curve

Attributes: Cun.re| Axes| Grid|

= |~

Ok | ‘ Apply | Cancel |

-

Figure 11.1 Upper part of Edit dialog
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b4 Edit Display Object x
10 Spectrum: A
_l Show Peaks _| Show Peak Marks
7 Show Integrals 7 Show Integral Labhels
_I Lahels above X axis 1 Show Scaling Information
Peaks Text Format: %3
Integrals Text Format: | =.2f
Integral Ymin, Ymax: |E—9.43333e+09 . 1.96496e+11
Units for X-Axes: 4 ppm - Hz - Points
Units for Peak Labels: ™ ppm - Hz - Points
Attributes: Peaks Integrals| Scaling Info
Basic MMR:
Data Set: Select from Porl:folio| |
£
3] =
Ok | ‘ Apply | Cancel |

-

Figure 11.2 Lower part of Edit dialog

11.3 Global Setup

Under Linux, the Global Setup dialog, which can be opened from the Options
menu, shows athree extra check buttons to show/hide the Satus Line, Toolbar and
Tips on Sartup (see Figure 11.3).
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b d Global Setup x

7 Show Status Line

7 Show Toolbar Hints
7 Show Tips on Startup

8
| JR
tarker Size (in pixel)

Blowup Offset(em): |1.5

Blowup Expansion Factor: | 8.0

7 Show Expansion Label

oKk | Apply |

Cancel
=1

=

Figure11.3

11.4 Printer Setup

Whereas under Windows Plot Editor can simply use the printer(s) installed in the
Operating System, under Linux the target printer must be setup once from the Plot
Editor.

To setup the printer you have to take the following steps:
1. Click Options — Printer Setup

The Printer Setup dialog will appear (see Figure 11.4)
2. Check/select the values of the following three settings:

e Printer Type: Post Scri pt

e Print Command: | pr %s

e Preview Command: gv %
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These are Bruker defined default values, which are usually correct and con-
figure the system default printer to be used as output device.

3. Set the Paper Size, Offsets and Output format to the desired values.
4. Click OK.

Note that the commands pl ot - ¢ and aut opl ot - c, internally extend the
print commandtol pr - P <pri nt er name> %, where <printername> is the
printer defined by the parameter CURPLOT.

Note that you can save the current values as the Default Setup as follows:
1= In the Printer Setup dialog: click File - Save As Default

The next time you open the Printer Setup dialog, the user defined defaults will
appear, instead of the Bruker defined.
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(Mote: Offsets refer to "Portrait”)

File |
Printer Type: Paper Size:
nx1z |-

EPSI Ledger
Acrobat PDF Legal

JPEG Letter

PCX (monochrome) Halfletter

PCX (8 bit gray scale) |Mote

PCX (24 bit color) A0

PHG Al

TIFF Az

TIFF {packed) AJ -
Left Offset (cm): 1.50
Right Offset (¢m): 1.00
Top Offset (cm): 1.50
Bottom Offset (cm): 1.50

-~ Portrait -~ Color

Output Format:

“* Landscape ™ Black & White

Splitto X* Y Pages: |1x1

Print Command:

Ipr %s

Preview Command:

igv %s

0K | Apply |

Cancel |

L

Figure 11.4 Print Setup dialog
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11.5 Standard EPS| object

Whereas under Windows, Plot Editor allows you to import Meta file graphics
(EMF or WMF), under Linux EPSI format is supported. You can import an EPSI
fileasfollows:

1. Click theradio button Standard at the left of the Plot Editor interface
2. Click the EPS icon:

and place the cursor at the desired position of the layout area.

3. Double-click the EPS object, click the Select button in the section EPSI
I mage of appearing dialog (see Figure 11.5), select the desired EPSI file
(usually files with the extension . eps or . epsi ) and click OK.

hd Edit Display Object x
Basic: =

Position (cm): |23 X8.6

Dimension {cm): I:s 3.7

Aftributes: Basicl

EP3I Image:

EP3I File: Selectl |7 Always resize graphics to fit in boundaries _| When resized keep original aspect ratio

Basic MMR:

Data Set: Select from Portfoliol

I~ T

Reset Aspect Ratio: _| Based on X-Dimension

_I Based on Y-Dimension

OK Apply | Cancel

Figure 11.5




182 Plot Editor under Linux

11.6 Miscellaneous

Apart from the difference in dialogs and setups there are afew minor aspects to be
considered under Linux .

e Theright-click popup menu might not work if the NumLock key on your
keyboard is activated. Press the NumL ock key to deactivate it.
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Chapter 12

Questions and Answers

12.1 Questionsabout the Plot Interface

How do | set the object marker size?
1. Click Option — Global Setup
2. Movethe slider Marker in the dialog Global Preferences
3. Click OK.

How do | set the Expansion and Offset of the Alt-Expand function?
1. Click Option — Global Setup
2. Enter avalueinthefield Blowup Expansion.
3. Enter avalueinthefield Blowup Offset.
4. Click OK.

How do | align objects exactly?
1. Click Option — Layout Setup
2. Select the desired Shap-In distance, e.g. to 0.5 cm, in the appearing dialog.
3. Click OK.
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New objects can only be placed to fixed grid positions which allows you to ex-
actly align them. When the Snap-In distanceis set to none, you can smoothly
move objects to any position in the layout.

To aign existing objects:

1. Double-click in the first object.

2. Click the Basic tab.

3. Enter the exact x- and y-position.
4. Repeat step 1 to 3 for each object.

How do | add integralsand integral labelsto a 1D spectrum?

1. Right-click the Spectrum object and choose 1D/2D-Edit from the popup
menul.

2. Enablethe entry Integralsin the middle of the dialog.
3. Click Close.

How do | add peak labelsto a 1D spectrum?

1. Right-click the Spectrum object and choose 1D/2D-Edit from the popup
menul.

2. Enablethe entry Peaksin the middle of the dialog.
3. Click Close.

How do | save a layout to the dataset PROCNO?
1. Click File— Save Layout/Portfolio to Dataset.
2. Select or enter the filename in the Save dialog.
3. Click Save

How do| set the number and distanceof X and Y Axis Ticks?

1. Right-click in the Spectrum object and choose Axis Tick Settings.. from the
popup menu.
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2. In the appearing dialog:

Axis Tick Settings &
[ Calculate axis ticks automatically
] % Bs 't Axds
Distance of labels: | 1 | 2e+006 ok |
# of minor kicks: | 9 | 1 Cancel
# of decimals: | 1] | 1
Figure12.1

a) Click one of theradio buttons Calculate axis ticks automatically or
Fixed Settings.

b) If you chose Fixed Settings: enter the Distance for the axis labels, the #
of minor ticks and the # of decimals, for both the X- and Y-axis.

¢) Click OK to save the changes and close the dial og.

How do | print scaling info (ppm/cm and Hz/cm) below the X-axis?
1. Double-click in the spectrum object.
2. Click the 1D Spectrum tab.
3. Enable the entry Show scaling infor mation for X-axis.
4. Click OK

Howdol insert alist (e.g. peak picking or integration results) on aplot,
in addition to thetitle?

1. Clickthe NMR Text icon and click inside the layout area (to placethe NMR
Text object).

2. Double-click in the NMR Text object.
3. Click the NMR Text tab in the dialog.

4. Enter the pathname of thelist file. Usually the file resides in the dataset
PROCNO. You can do that by specifying the full dataset pathname or using
the abbreviation +/filename. Alternatively, you can browse for the list file.

5. Click OK
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How do | put my company logo on the plot?

Bruker layouts have the Bruker logo in the upper right corner. You can easily re-
place this by your own company logo.

1

© N o gk~ w DN

0.

Enter | ayout onthe command line. In the appearing dialog, select the
desired layout.

Enter pl ot to open the Plot Editor interface.

Double-click in the logo object.

In the appearing dialog:

Click the Br owse button.

Select or enter your company logo graphics file in the appearing dial og.
Click OK to import the file and close the dialog.

Click File» Save and store the layout for later usage, in adirectory differ-
ent from <tshome>/plot/layouts.

Press Ct r | +p to plot the spectrum.

How do | use the same layouts on all computers, laboratory-wide?

1

Store your plot layouts on a network folder (Windows share, or NFS-
mounted Linux directory).

Click Options — Preferences.

. Inthe appearing User Preferences dialog:

a) Click Directory Path Namesin the |eft part of the dialog.

b) Click the Change button for the item Global search path for plot layouts.
c) Enter the Administrator password as requested.

d) Enter the network folder in the appearing dialog.

e) Click OK to closethedialog

f) Click OK to close the User Preferences dialog

Step 2 and 3 must be performed on each computer on which you want to plot.
After doing that, pl ot andaut opl ot will usethelayoutsin the network fold-
er rather than the layouts of the local ToPSPIN installation.
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How do | use my own layoutswith Bruker experiments?

1. Modify Bruker layouts or create your own new layouts and save themin a
layout directory (different from <t shone>/ pl ot/ | ayout s).

2. Add the new layout directory, to the layout search path (see step 2 and 3in
paragraph ).

Now pl ot andaut opl ot will usethelayoutsin the new layout directory rath-
er than the layoutsin <t shone>/ pl ot / | ayout s.

How do | modify the plotx command to my needs?

The command plotx is actually an AU program which can be modified.
1. Inthe TopsPIN window, enter edau pl ot x.

2. Make any modifications. See also paragraph 7.8 and the manuals AU Pro-
gramming and Plot Layout Programming.

3. Save and compile.

How do | select the parameter sthat must belisted on the plot?
1. Inthe TopsPIN window, enter par pl ot .
2. Select Acquisition Parametersor Processing Parameters.

3. Moveall parametersto be listed to the column Show and all other parame-
tersto the column Hide.

4. Click OK.
Any plot created by pl ot , aut opl ot or ICON-NMR will show the selected pa-
rameters. For more information enter hel p par pl ot .

How do | switch the Sartup and Toolbar Tips on/off under Linux?
1. Click Options — Global Setup
2. Enable/disable the respective checkboxes.

How do |, under Linux, overridethe printer defined in the layout?

As under Windows, you can do that by using the commands pl ot - ¢ and au-
t opl ot - ¢ (or by enabling the respectiveitem inthe pri nt dialog).

With the- ¢ argument, pl ot and aut opl ot , internally convert the print com-
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mand ¥ from:
| pr %
into
| pr -P <printernane> %-P printernane
where <printername> is the value of the parameter CURPLOT

Thisworks on all CUPS enabled Linux systems (which is the default) because
they typically usel pr % as aprint command. If your system does not use the
| pr semantic, please consider using a shell script that extracts the "-P printer-
name" information and translates it to aformat you need.

How do | generate multiple plots per dataset in automation?

1. InlconNmr Configuration: Go to User Settings- User defined parame-
ter sand append the parameter layout.

2. InlconNmr Automation: For each experiment, set the parameter layout to
the desired layouts, separated by semi-columns, e.g.:

+/1D_H.xwp;+/1D_H+int.xwp

Alternatively, you can set the processing parameter LAY OUT to the desired val-
ues.

12.2 Questions about plot procedures

How do | position a spectrum at the bottom of the window?

1. Right-click the Spectrum object and choose Automation from the popup
menu

2. Inthe Automation dialog:
a) Enable Keep zero line fixed on

b) Enter the exact relative position of the spectrum baseline, in the field %
of the box, e.g. 4,55.

¢) Click OK to closethedialog

1) Asset with Options — Printer Setup
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3. Right-click the Spectrum object and choose Reset Object from the popup
menu.

4. Click File » Save as... to save the layout for later usage.

How do | position a spectrum in the middle of the window?

1. Right-click the spectrum object and choose Automation from the popup
menu

2. Inthe AUtomation dialog:
a) Enable Keep zero line fixed on

b) Enter the exact relative position of the spectrum baseling, in the field %
of the box, e.g. 50.

c) Click OK to closethe dialog
3. Right-click the spectrum and choose Reset Object from the popup menu.
4. Click File » Save as... to save the layout for later usage.

How do | plot the entire spectrum
1. Start TopsPIN and open the dataset to be plotted.
2. Click the [ww] button to display the full spectrum

3. Enter | ayout onthe command line. In the appearing dialog, select the
desired plot layout.

4. Enter pl ot . The Plot Editor interface will appear, showing the layout
defined by the parameter LAY OUT. The Spectrum object will show the
entire spectrum.

5. Click File — Print to print the spectrum.

Alternatives;

e Enter pr nt , instead of step 3, 4 and 5, to print the data window as you
see it on the screen, without using a plot layout.

e Enteraut opl ot -f,instead of step 4 and 5, to directly send the output
to the printer rather than view it first.

o After step 4, right-click the Spectrum object in the Plot Editor interface,
choose 1D/2D-Edit, and click the icon:
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I%) and click Close, to display the entire spectrum. Then do step 5.

How do | plot a certain spectral region.

1
2.

5.

Start TopPsPIN and open the dataset to be plotted.

Select a certain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

Enter | ayout onthe command line. In the appearing dialog, select the
desired plot layout.

Enter pl ot . The Plot Editor interface will appear, showing the layout
defined by the parameter LAY OUT. The Spectrum object will show the
entire spectrum.

Click File — Print to print the spectrum.

Alternatives:

e Enter prnt, instead of step 3, 4 and 5, to print the data window as you
see it on the screen, without using a plot layout.

e Enteraut opl ot -f,instead of step 4 and 5, to directly send the output
to the printer rather than view it first.

e After step 4, right-click the Spectrum object in the Plot Editor interface,
choose Edit, and enter the exact Xmin/Xmax valuesin the Edit dialog.
Then do step 5.

How do| createa Sacked Plot ?

1
2.

Start TopsPIN and open first dataset of the series of spectrato be plotted.

Enter pl ot . The Plot Editor interface will appear, showing the dataset
according to the layout 1D_H.xwp.

Select a certain spectral region. To do that, click-hold in the data window
and drag the cursor line along the desired region.

Click the Stacked Plot icon:
Place the cursor in the layout area at the desired position. Click-

hold and move the mouse to draw the Sacked Plot object and re-
|ease the mouse.

Click the Data button of the command bar to open the Data Set sel ector.
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6. Click Edit inthe Data Set Selector dialog to open the Portfolio Editor.
7. Inthe Portfolio Editor:

a) Select the additional datasetsto beincluded in the Stacked plot. For each
dataset, click the Append button to add it to the Portfolio list.

b) Click Apply to load the Portfolio list to the Data Set Selector.
8. Click OK to closethe Data Set Selector.
9. Right-click the Sacked Plot object and choose Edit from the popup menu.
10.1n the appearing dia og:

a) Click the Stacked tab.

b) Enter the number of spectra

c) Enter the horizontal and vertical offset or accept the default values.

d) If you want the white washed effect (only foreground curves visible),
enable the respective White Washed checkbox.

e) Click OK.

Note that the White Washed checkbox defines a onetime action on OK. Itisal-
ways disabled on opening the edit dialog. To undo the white washed effect, you
must do the following.

1. Right-click in the Sacked Plot object.
2. Click the Attributes button in the Curve section.
3. Inthe appearing dialog, click the Default button, then click OK.

Note that the standard AU program st ack 1d automatically creates a stacked

plot of aseries of 1D spectrain consecutive EXPNO’s or PROCNO'’s. For a de-

scription of Automation Reset Actions on Stacked Plots, see paragraph 8.4.
How do | print individually scaled integral regions?

TopsPIN supports printing individually scaled integral regions. To do that:
1. Determine the integral regions, automatically with abs or interactively.
2. Enterpl ot x <scal i ng factor>

where scaling factor is the x-axis scaling factor (default 200).
See also paragraph 7.8
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How do | show the full spectrum after Expand?
1. Right-click in the Spectrum object and choose 1D/2D-Edit.
2. Inthe appearing dialog, click the following icon:

<P

3. Click Closeto close the dialog

How do | show the digital signature on the plot without the parame-
ters?

1. Create a Parametersobject in the layout area (if it is does not yet exist)
2. Double-click the Parameters object.
3. Inthe appearing dialog:

a) Disabletheitem: Allow automatic font resize

b) Click the Parameter tab

¢) Enabletheitem Include electronic signatureinformation

d) Click OK.

4. Resize the object such that only the area of the digital signatureisvisible
and the parameters are hidden.

When | export a spectrum to PDF and zoom in Acrobat Reader the
peak lines are coar se and detailsmissing! How do | solvethisproblem?

PDF files are exported with adefault data sampling rate of 360 dpi whichis suit-
ablefor printing. To see more details you have to increase the export sampling
rate.

Automated printing:
1. Enteraut opl ot -x <sanpling rate> -e <fil enanme>. pdf
eg.autoplot -x 1200 -e ny_data. pdf
Interactive printing:
1. Enter pl ot
2. Inthe Plot Editor interface:
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a) Click File » Export

b) Select or enter file name and the file type PDF in the appearing dia-
log.

c) Click Save.

d) Select or enter asampling rate larger than 360 in the appearing dial og.

e) Click OK.

Note that the file size will increase with increasing sampling rate.

How do | dynamically create plot layouts during automation?

TopspPIN 2.0 and newer support automated layout creation. You can create AU
programs for fully dynamic layout creation using the edau command and the
AU macrosLAYOUT _xxx. (seeparagraph 7.3 and 7.9). For afull description of
automated layout creations see TOPSPIN Help — Manuals — Programming
manuals — Plot Layout Programming.

How do | forcea 1D Spectrum object to use specific ppm/cm?

1. Right-click in the Spectrum object and choose 1D/2D-Edit from the popup
menu.

2. In the appearing dialog:
a) Select ppm and enter the desired value in the field per cm
b) Click Use Values, then click Close.

How do | avoid alarge (signal) peak to be used for scaling?
L ar ge solvent peaks

For large solvent peaks, there is a standard procedure which is used in most
Bruker standard experiments/layouts. To usein your own experiments/layouts
do the following:

1. Inthe TopspPIN interface, enter sr egl st to set the parameter SREGL ST.
Select the region file, according to the nucleus and solvent used in the
experiment. D

2. Enter pl ot to open the Plot Editor interface.

1) Regions file can be edited or new ones created with the command edlist scl.
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5.
6.
7.

Right-click in the Spectrum object and choose Automation.

In the Automation dial og:

a) Enable Useregion file on reset.

b) Select Defined by SREGLST

¢) Click OK

Right-click in the Spectrum object and choose Reset Object to see the effect.
Click File —» Print to plot the spectrum.

Click File - Save to save the layout for later usage.

To use thisin automation, read your experiment (parameter set) with r par , set
the parameters SREGL ST and LAY OUT to thedesired region file and to layout,
respectively and store the experiment withwpar . Do thisfor the experimentsto
be used in automation.

L arge non-solvent peaks

1

2.

3.

© N o g &

0.

In TOPSPIN, enter . i nt  to open the interactive integration mode.
Click = toselect and then ¢ to delete al integrals. L)

Click = and definetwo large integrals, one to the left and one to the
right of the large peak, covering the regions to be considered in scaling.

Click & andchoose Save Regions To 'reg'.

Click | toleave integration mode without save.

Enter pl ot to open the Plot Editor interface.

Right-click in the Spectrum object and choose Automation.

In the Automation dial og:

a) Enable Useregion file on reset.

b) Select reg

¢) Click OK

Right-click in the Spectrum object and choose Reset Object to see the effect.

10.Click File — Print to plot the spectrum.

1) Integrals are only deleted on the display, not on disk.



Questions and Answers 197

11.Click File — Saveto save the layout for later usage.
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Appendix A

13.1 Shortcuts

Frequently used menu or toolbar commands can also be executed with shortcuts.
This means the command is executed by pressing a certain key together with a
modifier key likeCtrl or Shift orAlt.
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Esc | Switch to selection mode

F1 | Open the Plot Editor Manual

F5 | Refresh

Al t +F4 | Close the Plot Editor interface

Ctr| +Shi ft +F6 | Display previous layout

Ctr| +t ab | Display next layout

del et e | Delete the marked objects

Ctrl +a | Mark all objects

Ctr | +c | Copy the marked object(s) to the Clipboard

Ctrl +g | Group the marked objects

Ct r | +Shi f t +g | Ungroup the marked object(s)

Ctrl +i | Open TopsPiN Command Interface

Ctrl +l | Lower the marked object(s)

Ctr | +m| Unmark all objects

Ctrl +n | Open anew layout

Ctr | +o | Open an existing layout

Ctr | +p | Print the current layout

Ctrl +q | Closethe Plot Editor interface (Linux only)

Ctr | +r | Raise the marked object(s)

Ctr | +s | Save the current layout

Crl + |Reset X andY scaling of the marked objects

Ctr | +v | Paste the object from the Clipboard

Ct r | +w | Open the attributes dialog window

Ctr | +x | Cut the marked object and place it on the Clipboard

Ctrl +z | Undothe last action

Note that shortcuts might not work when keys like Num Lock, Scroll Lock or
CapsLock are pressed.
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14.1 Plot command list

TopspIN offers various plot related commands, al of which are discussed in this
document. Here isa short list of plot related commands and their functions.

print [Ctrl +p]

Open the print dialog, from which you can set various options and start the com-
mands pr nt , pl ot or aut opl ot .

pr nt

Print the current dataset as you see it on the screen

pl ot

Open the Plot Editor for viewing, modifying, creating and printing plot layouts.
aut opl ot

Print data according to a Plot Editor layout.

par pl ot

Specify the acquisition and processing parametersthat must be listed on the plot.
pl ot x
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Print individually scaled integral regions, sending the output to the Plot Editor
or to the printer (AU program).

st ackld

Create a stack plot of aseries of 1D spectrain consecutive EXPNQO’s or PROC-
NO’s (AU program).

14.2 Command line argumentsfor plot

pl ot

Starts the Plot Editor using the same plot limits and intensity scaling (parameter
CY) asthe TopsPIN data window.

plot -c

Override the plotter in the layout by the plotter defined by the parameter CUR-
PLOT.

plot -r

Startsthe Plot Editor while performing the Reset Actionsfor setting the plot lim-
its and intensity scaling of individual Spectrum objects.

plot -n

Starts the Plot Editor with the plot limits and intensity scaling asit isdefined in
the layout for each Spectrum object. Limits and intensity are not adjusted to the
current dataset, nor are Reset Actions performed.

pl ot <l ayout >
Starts the Plot Editor with the specified layout, e.g. pl ot 1D _h+pp. xwp.
pl ot <l ayout 1> <l ayout 2>

Starts the Plot Editor showing the current dataset in two separate layouts;
<layout1> and <layout2>.

plot -p <portfolio>

Starts the Plot Editor with the specified portfolio, e.g.:

pl ot C:.\pf\nypf.port

The Plot Editor can also be started from the Print dial og, which shows the most
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important print options.

14.3 Command line argumentsfor autoplot

Although command aut opl ot isnormally used in automation, in form of the
macro AUTOPLOT, it can be used from the ToPSsPIN command line.

e usesthe layout defined by the processing parameter LAY OUT

e usesthe limits and intensity scaling of ToPSPIN current dataset window per-
forming the Reset Actions

e usesthe portfolio defined inthefileport f ol i 0. por inthe current data-
set procno, or, if this does not exist, the default portfolio.

aut opl ot supports anumber of command line arguments, which can be used
e.g. when writing sophisticated AU programs.

autopl ot -c

Print the data on the plotter defined by the parameter CURPLOT, overriding the
plotter in the layout.

autopl ot -f
Do not perform the Reset Actions.
aut opl ot -n

Use limits and scaling as defined in the layout. Ignore the current dataset limits
and scaling. Do not perform Reset Actions.

autopl ot -e <out put _nane>. ps

Create e.g. aPostscript fileinstead of printer output. Usethe - ? argument to see
acomplete list of supported file formats.

autopl ot -s setup.prt

Use printer setup file set up. prt instead of the printer setup that was saved
with the layout (not available in Windows version). A printer setup file can be
created from the Plot Editor interface with Options — Printer Setup.

autoplot -1 N
Remove N datasets from the portfolio and print again.
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aut opl ot <l ayout >
Print with the specified layout, e.g. aut opl ot 1D _h+pp. Xxwp.
aut opl ot <l ayout 1> <l ayout 2>

Print data twice using layouts <layout1> and <layout2>, respectively.

14.3.1 Portfolio arguments

aut opl ot also supports anumber of portfolio related command line arguments:

autopl ot -p portfolio.por

Loads the portfolio fileport f ol i 0. por

autopl ot -a portfolio.por

Like - p, but appendsto the portfolio instead of overwriting its contents
autoplot -d /u/datal...

Adds dataset / u/ dat a/ . . . tothe portfolio
autoplot -r /u/datal...

Removes dataset / u/ dat a/ . . . from the portfolio
aut opl ot -sa

Sorts portfolio in ascending order

aut opl ot -sd

Sorts portfolio in descending order

aut opl ot can take multiple portfolio arguments. For example:

autopl ot -p myportfolio.por -sa -r C:./bio/datal/guest/
nnr / denospect/ 1/ pdata/ 1

plotsthe datain myportfolio.por, except for dataset demospect/1/1, in ascending
order. Notethat the arguments are eval uated | eft to right and their order in which
they are specified matters.

14.3.2 Other options

autopl ot -v Show aut opl ot version number
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autopl ot -h Show help text
autoplot -7 Sameas- h
aut opl ot - - Explicit end of options. Use this option before specifying

alayout filethat hasa- asitsfirst letter.

14.4 Parameters used for plotting

TopspPIN defines a large number of acquisition and processing parameters. The
processing parameters which are used in relation to plotting are described bel ow.

LAYOUT - Plot Editor layout
« takes a filename as value, by convention with the extension . xwp
e interpreted by pl ot , aut opl ot and ICON-NMR plotting
e can be set by entering | ayout or pri nt or by clicking Procpars

CURPLOT - target printer
« takes an installed printer as a value
e interpreted by pl ot , aut opl ot and ICON-NMR plotting
e can be set by entering cur pl ot or pri nt or by clicking Procpars

AUNMP - the AU program to be used for automated processing and plotting
« takes an AU program name as value
e interpreted by xaup and ICON-NMR processing and plotting
e can be set by entering aunnp or by clicking Procpars

F1P/F2P - low/high field limit of the plot region in ppm

« takes a float value (ppm)

e interpreted by pl ot -r and aut opl ot (reset actions)

e set by pl ot and aut opl ot -f (no reset actions)

e can also be set by entering f 1p/f 2p or by clicking Procpars
CY - height of the reference peak

« takes a float value (cm)

e interpreted by pl ot and aut opl ot -f (no reset actions)
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e interpreted by pl ot -r and aut opl ot if the reset action: Size of
biggest peak = defined by parameter CY

e can be set by entering cy or by clicking Procpars
SREGLST - region file used for determining the scaling reference peak
« takes a filename as value, typically nucl eus. sol vent

e interpreted by pl ot -r and aut opl ot if the reset action Use
region file on Reset = defined by SREGLST

e can be set by entering sr egl st or by clicking Procpars
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screenshots 9
search path 35, 122, 123, 136, 137, 194, 195
second dataset 46
select

axes 24

grids 24

integrals 24

peaks 24
Shift key 54, 55, 89, 205
Shift modifier key 84
shortcuts 205
signal peak 202
special characters 108
SREGLST parameter 202, 212
stackld AU program 80, 200, 208
stacked plot 78
Standard radio button 28, 90, 129, 170, 187
status line 32, 35, 43, 51, 66, 73, 74, 76, 183

T

Text tab selected 26
third dataset 46
Title icon 28

toolbar 43, 51, 57
tools area 51

U

Undo button 24, 56, 89

undo last operation 24

Ungroup button 56, 88

ungroup objects 87

Use Values 97

User Preferences 123, 136, 194

w

wrp command 32, 140
WYSIWYG 43

X

xfb command 167
Xmin/Xmax field 26



z

Zoom 51

Zoom icon 24

Zoom in button 51
Zoom out button 51, 56
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